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Pre-Mechanical 

The projects section is the core component of the Autodesk Design Academy curriculum.  

The Pre-Mechanical section includes nine units with each unit consisting of multiple lessons 
and exercises. In addition, there are several student projects. 

Content 

• Unit 1 - What is Mechanical Engineering? 

• Unit 2 - Manufacturing a Part 

• Unit 3 - Introduction to Autodesk Inventor 

• Unit 4 - Create Features in Autodesk Inventor 

• Unit 5 - Placed Features in Autodesk Inventor 

• Unit 6 - Document a Part in Autodesk Inventor 

• Unit 7 - Assembly Modeling in Autodesk Inventor 

• Unit 8 - Documenting an Assembly 

• Unit 9 - Functional Design 

• Projects 
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Unit 1 - What is Mechanical Engineering? 

Introduction 

Mechanical engineering involves the design, construction, and operation of power plants, 
engines, and machines. It deals mostly with mechanisms that move. A common way of 
categorizing mechanical engineering is by heat utilization or machine design. The 
generation, distribution, and use of heat is applied in boilers, heat engines, air conditioning, 
and refrigeration. Machine design is concerned with hardware, including that which makes 
use of heat processes.  

The History of Mechanical Engineering 

The Industrial Revolution originally referred to the developments that transformed Great 
Britain, between 1750 and 1830, from a largely rural population making a living almost 
entirely from agriculture to a town-centered society engaged increasingly in factory 
manufacture. 

Before the Industrial Revolution there were only two kinds of engineers. The military 
engineer built such things as fortifications, catapults, and, later, cannons. The civil engineer 
built bridges, harbors, aqueducts, buildings, and other structures. In early 19th century 
England, mechanical engineering developed as a separate field to provide manufacturing 
machines and the engines to power them. The first British professional society of civil 
engineers was formed in 1818; one for mechanical engineers followed in 1847. In the 
United States, the order of growth of the different branches of engineering, measured by 
the date a professional society was formed, is civil engineering (1852), mining and 
metallurgical engineering (1871), mechanical engineering (1880), electrical engineering 
(1884), and chemical engineering (1908). Aeronautical engineering, industrial engineering, 
and genetic engineering are more modern developments. 

Founded in 1880 as the American Society of Mechanical Engineers, today's ASME is a 
120,000-member professional organization focused on technical, educational and research 
issues of the engineering and technology community. Click the link below to review their 
activities and publications.  

American Society of Mechanical Engineers (ASME)  
www.asme.org 

The Mechanical Design Process 

Typically, the design process focuses on three areas; product design, business, and 
manufacturing. These three areas consider topics such as the form and function of a design, 
the needs of the target market, and the ability to manufacture the product in a cost-efficient 
way. 

Companies such as Boothroyd Dewhurst have software to systematically analyze product 
designs with the goal of reducing manufacture and assembly costs, improving quality and 
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speeding time to market. This process is known as Design for Manufacturing and Assembly 
(DFMA). Click the link below to review their activities and publications.  

Boothroyd Dewhurst 
www.dfma.com 

The Tools of Mechanical Design 

Engineers through the years have advanced from simple measuring tools and calculating 
devices to computer aided design (CAD) performed on powerful computers. Autodesk® 
provides us with a good example of a company who revolutionized the software industry 
with the AutoCAD® product, which introduced drafting on a PC. The widespread popularity 
of AutoCAD software introduced engineers worldwide to the capabilities of CAD.  

For example, TBS Design, Portland, Oregon designed the oil module shown in the following 
image using AutoCAD software.  

 

The use of 2D and 3D design tools enhances the design process. In addition to using 
AutoCAD software, designers can create 3D solid models and analyze their designs using 
Autodesk Inventor. This provides the designer with the tools to go from concept and design 
to production more quickly. 

For example, J.S. McNamara, a leading design and engineering supplier to the automotive 
industry, created the overall design for the assembly machinery project for the Hummer H2 
and turned the designs over to its partner Lamb Technicon to build and install the designs.  
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To review a video presentation of this project, click on the following link, and then click View 
Video located below the Hummer image.  

J.S. McNamara 
Hummer H2 

For a comprehensive review of design, click on the following link.  

Design Gallery 
Industrial Machinery 

The design process involves the testing or creation of prototypes. Using stress analysis, 
designers can use the existing 3D data to test and modify a design. In the following image, 
a designer is analyzing the vibration in a design. Based on the results, the part can be 
modified and re-analyzed without the cost of creating a prototype. 
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Unit 2 - Manufacturing a Part 

Introduction 

The design process cycle consists of clearly defined phases that lead to the successful 
design and manufacturing of a part or assembly. 

In this unit, you review the design process and focus on manufacturing a part for a mini-
scooter.  

About This Unit 

You will review various software applications as you progress through the design process. 
These include Autodesk® InventorTM Professional 2008 and MasterCAM®.  

Lesson 

• The Design Process 
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Lesson 1 - The Design Process 

Mechanical design is the broad-based integration of art and engineering. It combines the 
study of science, language, business, and our society. Applied design and the systematic 
application of its principles are the basis behind using technological design. 

To assure that the design of a part or assembly is carried out in a systematic way, 
predefined steps are combined to form the design process cycle. 

Exercises 

• Review the Design Process Cycle 

• Sample Design Process 

• Document the Solution 

• Test the Solution 

• Manufacture the Part 
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Standards 

This lesson meets standards for Science Content, Math, Language Arts, and Technology. 

Key Terms 

design 

design process cycle 

Evaluation 

Students will be evaluated on completion of the exercises.  

Resources 

Exercises 
Autodesk Inventor web page www.autodesk.com\inventorpro 

Procedure 

1. Review the design process. (Discussion) 
 
2. Complete Exercise: Review the Design Process Cycle. (Student) 
 
5. Complete Exercise: Analyze, Define, and Review the Solutions. (Student) 
 
6. Complete Exercise: Document the Solution. (Student) 
 
7. Complete Exercise: Test the Solution. (Student) 
 
8. Complete Exercise: Manufacture the Part. (Student) 
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Exercise 1 - Review the Design Process Cycle 

Review the six steps of the design process cycle. 

This exercise illustrates which scientific principles are applied for the solution of everyday 
problems. 

Steps of the Design Process 

The following six steps outline the design process:  

• Analyze the situation 

• Define the problem 

• Review the solutions 

• Document the solutions 

• Test the solutions 

• Manufacture the product 

Analyze the Situation  

Before starting the design, analyze the market and the need for a new or revised product. 

Define the Problem 
A clearly stated list of requirements is created using the following criteria:  

• Function: This answers the question "What is the purpose of this design?" In some 
examples, the function of the parts negates the need for the form to be visually 
appealing. If the part is not visible to the user, then the function outweighs form. 

• Form: The final product must be visually appealing. This combines shape, color, and 
materials selected. 

• Materials: The materials used in the mini-scooter will meet specific criteria on cost 
and physical properties such as durability, strength, mass, and rigidity. 

• Construction: The construction must consider two aspects. The first is the 
manufacturing process to create the parts. The second is how easy will it be for the 
user to attach the add-on. 

• Safety and Reliability: Since the add-on is being marketed as an enhancement to 
power users, this category has to be carefully considered by the design team.  
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Review the Solutions  

Two solutions are presented to the company for consideration. Prior to reviewing these 
solutions, a list of criteria is created. The list weighs items such as cost, visual appeal, ease 
of use, safety, manufacturing process, and feedback from user focus groups. 

Document the Solution  

When a solution is selected, the design team can start the process of modeling the parts in 
Autodesk Inventor. The preliminary sketches and conceptual design are used in conjunction 
with the existing model of the mini-scooter to create an assembly of the solution. 

In addition, drawings and a parts list are created to complete the documentation of the 
assembly. 

Test the Solution  

Testing the solution includes processes such as finite element analysis, rapid prototyping, 
and simulation of the manufacturing phase. 

Manufacture the Product  

Manufacturing is the process of creating the product using machinery. Typically, the part 
model is translated into numerical control software that generates the necessary code to 
produce the part. The software is also capable of simulating the machining process, which 
eliminates the need to machine test parts and reduces overall costs. 

In this exercise, you reviewed six steps of the design process cycle. 
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Exercise 2 - Sample Design Process 

In this example, a manufacturer reviews new sources of revenue based on a line of mini-
scooter products. The manufacturer proceeds using the standard steps in the design process 
cycle.  

 

Analyze the Situation 

The mini-scooter manufacturer is having success with their current range of products. In 
addition, modified parts such as colored handle grips and different styled wheels have added 
to the product range. However, scooter users are demanding additional parts that enhance 
the performance of the mini-scooter. Based on this input, the company formed a number of 
focus groups to review what add-ons users would like. 

The most common requests were wheelie bars and snowboard conversion packages. 

The wheelie bar enables users to perform stunts by placing their foot on a rest located 
behind the rear wheel. The snowboard conversion is more complex and expensive since it 
requires the removal of the existing base and the attachment of a snowboard. 

The company then brings together representatives from departments that can best develop 
costs and project sales for the two modifications. These departments include engineering, 
manufacturing, and sales and marketing. 

The cost and projected sales of the two modifications are compared and the wheelie bar is 
selected because it provides a less expensive solution with more sales potential. 
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Define the Problem 

The wheelie bar will be added to the rear of the mini-scooter. Upon review, the rear wheel 
assembly has a wheel, axle assembly, and brake assembly that have to be considered 
during the design of the wheelie bar. Views of the assembly in Autodesk Inventor are as 
shown: 
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Review the Solutions 

Two solutions are presented by the engineering team for review. 

The first solution attaches the wheelie bar to the base, and the second is attached to the 
rear wheel using a revised axle assembly. Sketches and conceptual models are provided by 
the engineering team. The sketch of the second solution is as shown: 

 

A review of each solution is undertaken by the engineering and manufacturing teams. A 
summary of their comments is provided. 

Solution #1 

• Provides a wide footrest for the user. 

• Requires drilled holes in the baseboard for the assembly of the wheelie bar. 

• Complex assembly technique for aftermarket add-on. User could damage baseboard 
in drilling phase. 

Solution #2 

• Width of bar for footrest needs to reviewed. 

• Easy assembly technique for an aftermarket add-on. 

• Parts of existing rear wheel axle can be used. 

The review team analyzed the two solutions and selected the second submission. This 
decision was based on ease-of-assembly and concerns over the requirement for drilled holes 
with the first solution. 

The next step is to inform the engineering team of the decision and asked them to proceed 
to the next phase of the design cycle. 

In this exercise, you reviewed how two designs are compared, and why one design was 
selected over the other.  
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Exercise 3 - Document the Solution 

Now that the engineering team has approval to complete the design of the wheelie bar, they 
will use the most efficient method of documenting the solution.  

Document the Solution 

Documenting the wheelie bar can be completed in Autodesk Inventor using one of three 
methods: 

• Top-down: When you design from the top down, you begin with design criteria and 
create components that meet those criteria. Designers list known parameters and 
may create an engineering layout (a 2D design that evolves throughout the design 
process). 

• Bottom-up: When you design from the bottom up, you place existing parts and 
subassemblies into an assembly file, positioning components by applying assembly 
constraints, such as mate and flush. Components should be placed in the order in 
which they would be assembled in manufacturing, if possible. 

• Middle-out: Most assembly modeling combines the strategies of bottom-up and top-
down design. Some requirements are known and some standard components are 
used, but new designs must also be produced to meet specific objectives. This 
combined strategy is referred to as middle-out design. 

Given that the mini-scooter assembly already exists as an Autodesk Inventor model and 
standard parts will be used, middle-out assembly design will be used to document the 
model. 

Autodesk Inventor also provides part in-place modeling. Parts created in-place (in an 
assembly context) can be a specific size controlled by dimensioned sketches; or be 
adaptive, controlled by relationships to other assembly components. For example, a support 
for the wheelie bar can be modeled by projecting existing edges as the basis for the sketch. 

The following image illustrates how the edges of the wheel support on the scooter are 
projected and used as the sketch for the extrusion on the wheelie bar. If the wheel support 
is modified, then the wheelie bar support will adapt to the new size. 
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Using middle-out assembly design, the engineering team completes the wheelie bar add-on. 
The complete documentation package includes part files, a subassembly, and drawing files. 

Create a Subassembly  

The final design of the wheelie bar requires seven parts. Using assembly constraints, the 
parts are assembled as shown: 
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Create the Drawings  

Drawings of the assembly and each part are created. Manufacturing can use these drawings 
to make the parts, or the part files can be sent directly to computer-aided manufacturing 
software. 

 
 

 
 
In this exercise, you reviewed how to document the solution.  
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Exercise 4 - Test the Solution 

Simulation is a fast and reliable way to verify that product designs meet the needs of the 
end user. By subjecting products in electronic form to real-world conditions, expensive and 
time-consuming prototyping and testing can be avoided while still getting valid performance 
information that can optimize designs.  

To examine how parts will perform in the real world, you can execute stress and strain 
analysis directly in Autodesk Inventor. Executing this analysis is intended to occur early in 
the design process. In practice, the Design > Analyze > Redesign process occurs many 
times before the optimum design is achieved. The following example demonstrates a four-
step design process involving a finite element analysis simulation of a wheelie bar part. 

The assembly is attached to the scooter as shown. 

 

The wheelie bar is attached with a bolt through the wheel. 
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The part you want to analyze is the large support that goes from the wheel to the foot 
support. 

 

A simple review of the part shows that the weight reducing cutouts have sharp corners. This 
is generally considered bad design. Before running an analysis, fillets are added to the part. 

 

After looking at how the part is used, you apply a force on the hole as shown. 
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The stress analysis is run, and the software outputs an image. The colors identify the stress 
values throughout the part. This solution has no large areas of red, so the design is close to 
completion. 

 

In this exercise, you reviewed how to test the design using a finite element analysis 
simulation. 
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Exercise 5 - Manufacture the Part 

The documentation and testing are now completed and the manufacturing team can decide 
on their workflow. In this example, the Autodesk Inventor models will be transferred to a 
computer aided manufacturing system and the necessary numerical code (NC) will be 
generated for the part. 

In this example, the NC software application is Mastercam®. 

Step 1 

The solid model is brought directly into Mastercam in its native form without translation. 
Because there is no translation of data, true data integrity is assured. 

 

Step 2 

The NC programmer must select the proper holding fixture and assess the best way to cut 
the job. The availability of tooling may dictate the approach taken. 

Step 3 

Following tooling selection, the features for machining are defined. The stock and fixture are 
brought in to provide realistic verification in the simulator. 

Step 4 

The appropriate cutter is chosen and the operation best suited for the component is selected 
in Mastercam to remove the material in the most efficient manner. 
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Step 5 

When the tool path is finalized, the simulator displays the graphical representation and 
numerical information of how the part will be cut. If any changes need to be made to the 
cutter or operation, these changes can be made to the tool path before it is machined. 

 
 
 
In this exercise, you reviewed how to manufacture a part using numerical control software.  

© 2008 Autodesk, Inc.  20 



Autodesk Design Academy 2008  Pre-Mechanical Engineering 

Unit 3 - Introduction to Autodesk Inventor 

Introduction 

Autodesk Inventor® Professional is a parametric solid modeler that provides you with design 
tools that focus on the entire product development process. 

Your designs in Autodesk Inventor will exist in three dimensions. 

About This Unit 

You will use Autodesk Inventor as you progress through the design process.  

In this unit, the focus is on developing an effective workflow as you become familiar with 
the work environment and create sketches and parts. 

Lesson 

• Work Environment, Sketch Profiles, and Parts 
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Lesson 1 - Work Environment, Sketch Profiles, and 
Parts 

The Autodesk Inventor work environment includes the Autodesk Inventor window, graphics 
window, dockable toolbars, browser, panel bars, and context (right-click) menus. 
 

 
 
The panel bar displays the tools for the current environment. For example, the 2D Sketch 
panel bar contains the basic tools to create a sketch:  

• Lines  
• Arcs  
• Circles  
• Rectangles  

 

Using these tools, you create sketch profiles to represent the cross section of a feature. 
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The browser displays the hierarchical structure of parts, assemblies, and drawings.  

  

Exercises 

• Create a Sketch with Lines 

• Create a Profile with Tangencies 

• Add and Display Constraints 

• Dimension a Profile 

• Use the Measure Tools  
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Standards 

This lesson meets standards for Science Content, Math, Language Arts, and Technology. 

Key Terms 

browser feature IPT sketch 

curve IAM panel bar   

extrude IDW project   

Evaluation 

Students will be evaluated on completion of the exercises.  

Resources 

Exercises 

Autodesk Inventor web page 

Procedure 

1. Start a new part. (Demonstration) 
 
2. Review the Autodesk Inventor work environment. (Demonstration) 
 
3. Place lines, arcs, and circles to become familiar with sketch creation. (Demonstration and 
student practice)  
 
4. Complete Exercise: Create a Sketch with Lines. (Student) 
 
5. Complete Exercise: Create a Profile with Tangencies. (Student) 
 
6. Complete Exercise: Add and Display Constraints. (Student) 
 
7. Complete Exercise: Dimension a Profile. (Student) 
 
8. Complete Exercise: Use the Measure Tools. (Student) 
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Exercise 1 - Create a Sketch with Lines 

Create a new part file, and then use basic construction techniques to create sketch 
geometry. 
 
This exercise illustrates how you use the Autodesk Inventor online Design Support System 
(DSS) to assist in the design process.  

    

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Create a Sketch 

1. On the Standard toolbar, click New. Select the Metric tab, and then double-click 
Standard (mm).ipt. A new part is created and listed in the browser.  

2. On the 2D Sketch Panel, click Line. Click near the left side of the graphics window, 
and then move the cursor to the right approximately 100 units, and click a second point. 
 

Tip:  If the entire line is not visible on your screen, use the Zoom tool or the wheel on 
your mouse to zoom out and view the entire line. 
 
Note: The length, angle, and geometry of the line are dynamically displayed on the screen. 
The length and angle are displayed in the lower right corner of the window, and symbols 
indicate the geometric constraint. In this example, the symbol indicates that the line is 
horizontal.  
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3. Right-click in the graphics window, and select How To.  
 

 

• In Show Me Animations > Autodesk Inventor > Sketch Line section, click Lines > 
Perpendicular, and then watch the animation. 

 

• Close the Show Me animation window when you understand the concept. 

Tip: Use the controls at the lower edge of the dialog box to reset and replay the animation. 
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4. Move the cursor up approximately 40 units and create a perpendicular line.  
 

 

5. Move the cursor to the left and create a horizontal line of approximately 30 units. The 
symbols now indicate a parallel constraint.  
 

 

6. Move the cursor down and create a vertical line of approximately 10 units.  
 

 

7. Move the cursor left to create a horizontal line of approximately 40 units.  
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8. Move the cursor up until the symbols indicate a parallel constraint and a dotted line is 
displayed at the same height as the line on the right, and then click at that point.  
 

 

9. Move the cursor left until the symbols indicate a parallel constraint and a dotted line is 
displayed, and then click at that point.  
 

 

10. Move the cursor down until the symbols indicate a coincident constraint and a green dot 
is displayed, and then click at that point.  
 

 

11. Right-click in the graphics window, and select Done [Esc].  
 

 

12. Right-click again in the graphics window. Click Finish Sketch.  

13. On the File menu > Save Copy As using the class file-naming convention.  
 
In this exercise, you started a new part file, and then used the Line tool to create a sketch.  
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Exercise 2 - Create a Profile with Tangencies 

Create a new part file, and then use basic construction techniques to create a simple profile. 
The profile consists of lines and tangential arcs. 
 
In this exercise, you use the Autodesk Inventor online Design Support System (DSS) to 
assist in the design process.  

    

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Create a Profile with Tangencies 

1. On the Standard toolbar, click New. Select the Metric tab, and then double-click 
Standard (mm).ipt. A new part is created and listed in the browser.  

2. On the View menu > click Toolbar > Inventor Precise Input to display the Inventor 
Precise Input toolbar.  
 

 

3. On the 2D Sketch panel bar, click Line. Click near the left side of the graphics 
window, and then on the Precise Input toolbar, in the X field, enter 65.  

• Click the Precise Delta button. 
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• When the horizontal constraint is displayed, click a second point. 

 

Tip:  If the entire line is not visible on your screen, use the Zoom tool or the wheel on 
your mouse to zoom out and view the entire line. 

4. In the Y field, enter 15. When the perpendicular constraint is displayed, click a second 
point.  
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5. Move the cursor up and to the left, and then click to create a sloping line.  
 

 

6. Right-click in the graphics window and select How To.  

7. In Show Me Animations > Autodesk Inventor > Sketch Line section, click Arcs > Tangent, 
and then watch the animation.  
 

 
 
Tip: Use the controls at the lower edge of the dialog box to reset and replay the animation.  

When you understand the concept, close the Show Me window.  
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8. Move the cursor over the end of the line, hold down the left mouse button, and then drag 
the endpoint to create a tangent arc. Click to place the endpoint of the arc.  
 

 

9. Move the cursor to the start point of the profile and click at that point.  

Note: The line is not tangent to the arc. 
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10. Right-click in the graphics window, and select Done [Esc].  
 

 

11. Right-click again in the graphics window. Click Finish Sketch.  

12. Close the Inventor Precise Input toolbar.  

13. On the File menu > Save Copy As using the class file-naming convention.  
 
You started a new part file, and then used the Line tool to create a sketch with tangencies.  
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Exercise 3 - Add and Display Constraints 

Add geometric constraints to an existing sketch containing three closed loops. In some 
cases, you can greatly reduce the number of dimensional constraints required on a sketch. 
 
This exercise uses geometry that does not meet specified design criteria and requires 
additional geometric constraints.  

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Add and Display Geometric Constraints 

1. Open inv_unit3_03.ipt.  

2. On the Standard toolbar, click Look At, and then select any curve.  

3. On the Standard toolbar, click Zoom All to view the three profiles.  
 

 

4. In the browser, double-click Sketch1 to make it active.  

5. Zoom and pan to view the sketch profile on the left.  

6. On the 2D Sketch Panel, click Show Constraints. Pause the cursor over the sloping 
line on the left side of the sketch. The constraints are displayed.  
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7. On the 2D Sketch Panel, next to Constraint, click the down arrow to display the menu. 
Click the Vertical constraint tool, and then click the three sloping lines.  
 

 
 

 

8. Right-click in the graphics window and select Done [Esc].  
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9. Right-click in the graphics window again, and select Show All Constraints.  
 

 

10. Right-click in the graphics window again, and select Hide All Constraints.  

11. Pan to center your view on the second profile.  
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12. Apply a colinear constraint to the top horizontal lines.  
 

 

13. Apply an equal constraint to all the horizontal lines. 
 
Note: All lines should be made equal to the line at the lower left. 
 

 

14. Right-click in the graphics window, and select Done [Esc]. Drag the left vertical line to 
the right and note how the sketch changes. This is known as constrained drag.  

15. Pan to the third profile, and then apply constraints to complete the profile. 
 
Tip: Apply a tangent constraint to the left arc and line, apply equal constraints to make all 
three arcs the same radius, and align the arc centers using horizontal constraints. 
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16. Right-click and select Done.  

17. Right-click and select Finish Sketch.  

18. On the Standard toolbar, click Zoom All to view the three profiles.  

19. On the File menu > Save Copy As using the class file-naming convention.  
 
You opened an existing file, and then applied geometric constraints to three profiles. You 
also used constrained drag to review the effect of the constraints on the profiles.  
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Exercise 4 - Dimension a Profile 

Add dimensional constraints to a sketch. 
 
The sketch requires dimensional constraints to maintain its overall size. Geometric 
constraints have already been applied to maintain the shape of the sketch.  

 
 

 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Add Dimensional Constraints 

1. Open inv_unit3_04.ipt.  

2. In the browser, double-click Sketch1 to make it the active sketch.  

3. On the Standard toolbar, click Look At, and then select any curve.  
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4. On the Standard toolbar, click Zoom All to view the sketch.  

5. On the 2D Sketch panel bar, click General Dimension.  

6. Click the top horizontal line of the sketch, and then place the dimension.  

• Click the dimension to display the Edit Dimension dialog box. 

 

• Enter 135, and then click the check mark. 

 
 
In this example, you clicked the dimension to display the dialog box. If you are placing 
many dimensions, you can display the Edit Dimension dialog box automatically.  

7. With the General Dimension tool active, right-click the graphics window background, and 
then from the shortcut menu, select Edit Dimension. A check mark appears beside Edit 
Dimension.  
 

 

8. Complete the dimensional constraints as follows:  

• Add a dimension of 10. 
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• Add a dimension of 60. 

 

• Add a dimension of 35. 

 

• Add a dimension of 10. 
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• Add a dimension of 25. 

 
 
You will add one more dimension that is based on an existing dimension. This type of 
expression is a variable dimension.  
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9. Place a dimension as shown. 
 

 

• With the Edit Dimension box open, move the cursor over the 60 dimension until the 
pointer appears, and then click the dimension. 

 

• The parameter name is inserted into the Edit box. In this case it is d3. 

 

• In the Edit box, enter /2 after d3, and then click the check mark. This dimension will 
always be half of the overall height of the part. 
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Note: Dimensions driven by equations are denoted by fx: in the graphics window. 

10. Right-click, and then select Done [Esc].  

11. Double-click the 60 dimension, and then edit the value to 65. Note that the 30 
dimension updates to 32.5.  

12. On the File menu > Save Copy As using the class file-naming convention.  
 
You opened an existing file and then applied dimension constraints to a profile.  
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Exercise 5 - Use the Measure Tools 

Open an existing part file, and then use the measure tools to analyze the sketch. 
 
This exercise illustrates how you use the measure tools to measure the length of an edge, 
the diameter of a circle, the position of a point, the perimeter of the part, and the area of 
the part.  

 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Measure Distance 

1. Open inv_unit3_05.ipt.  

2. In the browser, double-click Sketch1 to make it active.  

3. On the Standard toolbar, click Look At, and then select any curve.  
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4. On the Standard toolbar, click Zoom All to view the sketch profile.  
 

 

5. On the Tools menu, click Measure Distance.  
 

 

6. In the graphics window, click the lower edge of the part. The length is displayed in the 
Measurement dialog box.  
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7. In the Measurement dialog box, click the arrow and select Restart.  
 

 

8. Hover the cursor over the small circle on the left until a diameter line is displayed, and 
then click to select it. The diameter is displayed in the Measurement dialog box.  
 

 

9. Hover the cursor over the center of the circle, and then click to select the point. The 
position of the point relative to each axis of the active coordinate system is displayed.  
 

 

10. Click the center point of the circle to the right. The position of the point and the delta 
position relative to the first point is displayed.  
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11. In the Measurement dialog box, click the arrow and select Measure Loop.  
 

 

12. Select the perimeter of the sketch to display the loop length.  
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13. In the Measurement dialog box, click the arrow and select Measure Area.  
 

 

14. Select the perimeter of the sketch to display the area.  
 

 

15. Right-click and select Done [ESC].  

16. Right-click again in the graphics window. Click Finish Sketch.  

17. Close the file. In this exercise, you analyzed a sketch using the measurement tools.  
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Summary/Questions of Work Environment and 
Sketch Profiles 

Summary 

In this lesson, you learned to: 

• Navigate the Autodesk Inventor user interface.  
• Create a new part file.  
• Create a sketch profile.  
• Add and display constraints.  
• Add dimensions to a sketch.  
• Use the measure tools.  

 

Questions 

1. What is the file extension of an Autodesk Inventor part file? 

a. DWG 

b. DOC 

c. IPT 

d. IAM 

2. What is the purpose of the symbols that are displayed when you create a sketch? 

a. To allow you to switch tools while sketching 

b. To indicate inferred geometric constraints 

c. To create markers for placed features 

d. To indicate what tool is being used 

3. To dynamically check how applied constraints are affecting the sketch, you can click and 
drag a curve noting its degrees of freedom. What is this process called? 

a. Constrained drag 

b. Curve drag 

c. Constraint display 
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d. Drive constraint 

4. You can only enter numeric values in the Edit Dimension dialog box. 

a. True 

b. False 
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Unit 4 - Create Features in Autodesk Inventor 

Introduction 

Autodesk Inventor® Professional is a parametric solid modeler that provides you with design 
tools that focus on the entire product development process. 

Your designs in Autodesk Inventor will exist in three dimensions. 

About this Unit 

You will use Autodesk Inventor as you progress through the design process.  

In this unit, the focus is on creating features from sketches. These include extrude and 
revolve. In addition, you create work features that enable the creation of construction 
geometry when the geometry is insufficient for creating and positioning new features. These 
include work plane, work axis, and work point. 

 

Lesson 

• Sketched and Work Features 
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Lesson 1 - Sketched and Work Features 

Sketched features originate from 2D sketches. Extrude and revolve are examples of 
sketched features. 
 
You use work features to create and position features, and when current geometry is 
insufficient for constructing additional features. To fix position and shape, you can constrain 
features to work features. 
 
Work features include:  

• Work planes 

 

• Work axis 

 

• Work points 

 

Exercises 

• Create Extruded Features 

• Create a Revolved Feature 

• Calculate Physical Properties 

• Create an Offset Work Plane 

• Create a Tangent Work Plane 

• Create a 3-Point Work Plane  

Standards 

This lesson meets standards for Science Content, Math, Language Arts, and Technology. 
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Key Terms 

work axis work plane 

work feature work point 

Evaluation 

You will evaluate students on the completion of the exercises.  

Resources 

Exercises 
Autodesk Inventor web page www.autodesk.com 

Procedure 

1. Review sketched features. (Demonstration) 
 
2. Review work features. (Demonstration) 
 
3. Complete Exercise: Create Extruded Features. (Student) 
 
4. Complete Exercise: Create a Revolved Feature. (Student) 
 
5. Complete Exercise: Calculate Physical Properties. (Student) 
 
6. Complete Exercise: Create an Offset Work Plane. (Student) 
 
7. Complete Exercise: Create a Tangent Work Plane. (Student) 
 
8. Complete Exercise: Create a 3-point Work Plane. (Student) 
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Exercise 1 - Create Extruded Features 

Open a part file, and from the same sketch geometry, create two extruded features. This 
exercise demonstrates how to use a single sketch to extrude features with different 
distances.  

 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Create Extruded Features 

1. Open inv_unit4_01.ipt.  
 

 

2. In the browser, right-click Sketch2, and select Visibility. The sketched geometry and 
dimensions are displayed. 
 
Note: Sketch2 is a shared sketch. The icon in the browser displays as a hand to indicate 
that the sketch is shared. 
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3. On the Part Features panel bar, click Extrude.  

• Move the cursor inside the lens-shaped profile, and click to select that profile. A 
preview of the extrusion is displayed. 

 

• In the Extrude dialog box, enter 36 for the distance of the extrusion, and click OK. 
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4. In the browser, right-click Sketch2, and then click Visibility.  

5. On the Part Features panel bar, click Extrude.  

• Move the cursor inside the remaining (oval) profile, and click to select the profile. A 
preview of the extrusion is displayed. 

© 2008 Autodesk, Inc.  57 



Autodesk Design Academy 2008  Pre-Mechanical Engineering 

 

• In the Extrude dialog box, enter 16 for the distance of the extrusion, and click OK. 

 

6. In the browser, right-click Sketch2 and select Visibility. The sketch and dimensions are 
no longer visible.  

7. On the File menu > Save Copy As using the class file-naming convention.  
 
You opened an existing part file, and then created two extruded features.  
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Exercise 2 - Create a Revolved Feature 

You open an existing assembly file that contains a number of parts, and then create a 
revolved feature to complete the clutch assembly.  

This exercise demonstrates how you revolve sketched geometry about an axis to create a 
revolved feature. In this example, you create a full revolution. You can also use other extent 
options to revolve a feature.  

 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Create a Revolved Feature 

1. Open inv_unit4_02.iam.  

Note: If a dialog box is displayed prompting you to update the assembly, click No. 

 

2. In the browser, expand inv_unit4_clutch2:1. Move the cursor to the Sketch1 icon. A 
preview of the sketch geometry and dimensions is displayed in the graphics window. 
 
For this exercise, you need to activate the part and make the sketch visible.  
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3. In the browser, double-click inv_unit4_clutch2:1 to activate the part.  

4. In the browser, right-click Sketch1 and select Visibility. The required geometric and 
dimensional constraints already exist on the sketch.  

5. Click Revolve.  

• The profile and axis are automatically selected. The axis line was created using the 
centerline style. 

 

• In the Revolve dialog box, in the Extents list, confirm Full is selected. The preview of 
the revolved feature also confirms the full extents. 
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• To create the revolved feature, click OK. 

 

6. On the Standard toolbar, click Return.  

7. On the File menu > Save Copy As using the class file-naming convention.  
 
You opened an existing assembly file, and then created a revolved feature.  
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Exercise 3 - Calculate Physical Properties 

You open an existing part, and then analyze the physical properties of the part.  

This exercise demonstrates how you analyze a part during the design process. This includes 
editing the material and calculating the mass properties of the part.  

 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Calculate Physical Properties 

1. Open inv_unit4_03.ipt.  
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2. On the File menu > iProperties. The Properties dialog box is displayed.  
 

 

3. Click the Physical tab, and then click Update. The properties of the part are displayed 
using the Default material.  
 

 

4. In the Material list, select Steel, Mild. The properties are updated using the values for 
mild steel.  
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5. Click OK. The part material display is updated to mild steel.  
 

 

6. Change the material to the following, noting the different properties:  

• Nylon-6/6  
• Stainless Steel, 440C  
• UHMW, White  

7. On the File menu > Save Copy As using the class file-naming convention.  
 
You opened an existing part file, and then calculated the physical properties for various 
materials.  
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Exercise 4 - Create an Offset Work Plane 

Create an offset work plane by selecting a face, dragging the work plane preview, and then 
entering an offset value. 

 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Create an Offset Work Plane 

1. Open inv_unit4_04.ipt.  
 

 
 
The thrust piece from a rocking lever requires that sketch geometry be created 84 mm from 
the base of the part. To do this, you create a work plane offset from a face.  

2. On the Part Features panel bar, click Work Plane.  

3. Move the cursor to the lower right corner of the part to highlight the front face.  
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Tip: Place the cursor closer to the bottom right corner of the face. 

4. Right-click on the part, and then choose Select Other. Click the arrows to cycle through 
the faces (if necessary) until the bottom face is displayed, and then click the green center 
button.  
 

 

5. Drag the plane up until the offset display is approximately -80 (negative). 
 
Note: If the Offset box is not visible, it may be displayed behind the exercise window.  
 

 

6. In the Offset dialog box enter -84 (negative), and then click the check mark.  

Note: The work plane offset is a negative value because the bottom face was selected and 
its normal vector points downward. 

7. The new work plane is created.  

• Move the work plane by clicking and dragging the edge of the plane. 

• Resize by clicking and dragging a corner of the plane.  
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8. On the File menu > Save Copy As using the class file-naming convention.  

Note: The work plane can be used to create features on the part. For example, this work 
plane was used to create a sketch plane and the features shown in the completed thrust 
piece. 

 
 
In this exercise, you opened an existing part file, and then created an offset work plane.  
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Exercise 5 - Create a Tangent Work Plane 

A shaft requires that a keyway be cut. To do this, you create a work plane that is tangent to 
the surface of the shaft.  

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Create a Tangent Work Plane 

1. Open inv_unit4_05.ipt.  
 

 

2. On the Part Features panel bar, click Work Plane.  
 
Next, you create a work plane that is parallel to the part's XZ Plane.  

3. In the browser, expand the Origin folder, and then click XZ Plane. A preview of the plane 
is displayed.  
 

 

4. Move the cursor over the top left end of the shaft. Since work planes are inferred, only 
possible solutions are displayed. In this example, moving the cursor over the top or bottom 
face displays one of two possible solutions.  
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5. Click to accept the work plane on top of the shaft. The new work plane is displayed.  
 

 
 
Note: This work plane was used to place a sketch plane to create the feature shown in the 
completed shaft. 
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6. On the File menu > Save Copy As using the class file-naming convention.  
 
You opened an existing part file, and then created a tangent work plane.  
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Exercise 6 - Create a 3-Point Work Plane 

A part requires the addition of a small bracket. The bracket is planar with the face of an 
existing feature. To add the bracket, you use three points on the feature to create a work 
plane.  

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Create a 3-Point Work Plane 

1. Open inv_unit4_06.ipt.  
 

 

2. On the Part Features panel bar, click Work Plane.  

3. Move the cursor to the right side of the part. Click the three points that define the work 
plane.  
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4. When you click the third point, the new work plane is created. Move and resize the work 
plane display if necessary.  
 

 
 
Note: This work plane was used to create sketch geometry on the work plane for the 
feature shown in the completed part.  
 

 

5. On the File menu > Save Copy As using the class file-naming convention.  
 
You opened an existing part file, and then created a 3-point work plane.  
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Summary/Questions Sketched and Work Features 

Summary 

In this lesson, you learned how to: 

• Create extruded features. 
• Change the physical material of a part.  
• Calculate the physical properties of a part. 
• Create revolved features. 
• Create work planes using various techniques. 

Questions 

1. No planar face exists to use as a sketch plane. Which work feature are you most likely to 
create first? 

a. Work plane 

b. Work axis 

c. Work point 

d. Any of the above 

2. Only one profile can be selected to create a revolved feature. 

a. True 

b. False 

3. Which of the following is NOT an extruded feature operation? 

a. Join 

b. Cut 

c. Combine 

d. Intersect 

4. You can have multiple active sketches at any time. 

a. True 

b. False 
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Unit 5 - Placed Features in Autodesk Inventor 

Introduction 

Autodesk Inventor® Professional is a parametric solid modeler that provides you with design 
tools that focus on the entire product development process. 

Your designs in Autodesk Inventor will exist in three dimensions. 

About this Unit 

You will use Autodesk Inventor as you progress through the design process.  

In this unit, the focus is on creating placed features. These features consist of a defined 
mechanical shape that function in a part or assembly. Examples are holes, chamfers, and 
fillets. 

 

Lessons 

• Place Holes, Threads, Chamfers, and Fillets 

• Create a Lofted Feature; and Emboss, Engrave, and Apply Decals to a Model 
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Lesson 1 - Place Holes, Threads, Chamfers, and 
Fillets 

In this lesson, you learn the usefulness of placed features. You discover some key 
differences between sketched features and placed features, and where and why you use 
each one. 
 
You do not have to create a sketch to define every feature on a part. You can create some 
features, like fillets and chamfers, by specifying values and selecting locations on a part. 

Geometric features that do not require sketches are called placed features.  
 

 
In addition to fillets and chamfers, other placed feature tools include hole, shell, pattern, 
and mirror. 

 

Exercises 

• Create Hole Features 
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• Create Threads 

• Create Chamfers and Fillets  

Standards 

This lesson meets standards for Science Content, Math, Language Arts, and Technology. 

Key Terms 

chamfer hole 

fillet placed feature 

Evaluation 

Evaluate students on the completion of the exercises.  

Resources 

Exercises 
Autodesk Inventor web page www.autodesk.com\inventor 

Procedure 

1. Review placed features. (Demonstration) 
 
2. Complete Exercise: Create Hole Features. (Student) 
 
3. Complete Exercise: Create Threads. (Student) 
 
4. Complete Exercise: Create Chamfers and Fillets. (Student) 
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Exercise 1 - Create Hole Features 

A cylinder head, which is part of a face-valve pump assembly, is partially complete. In this 
exercise, you add drilled, counterbore, and tapped holes to the cylinder head.  
 

   

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Create Hole Features 

1. Open inv_unit5_01.ipt.  
 

 

2. On the Standard toolbar, click 2D Sketch, and then click the rectangular face. The 
four arc centers are automatically projected into the sketch and will be used to locate the 
holes. 
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3. Right-click in the graphics window, and then click Create Feature > Hole.  

• In the Holes dialog box, the Placement option should default to From Sketch. 

• Select the four arc centers. 

• In the hole preview image, enter 6 mm for the hole diameter. 

• Click the down arrow in the Termination box, and then select To. 

 

• Pause the cursor over the face of the flange to highlight the underside face as 
shown. When the underside face is highlighted, click to select it. 

 

• Click OK. The hole feature is created and the icon is added to the browser. In this 
example, one feature defines all four holes. 
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Place a Tapped Hole 

1. On the Standard toolbar, click Rotate, and then press the SPACEBAR to display the 
Common View tool.  
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2. Click the arrow at the top left of the box. This will display the face for the threaded hole.  
 

 

• Press the SPACEBAR to remove the Common View tool. 

• Press ESC. 

3. On the Part Features panel, click Hole.  

• In the Placement section of the Holes dialog box, select the Concentric option. 

• Select the face. 

 

• Select the cylindrical face. 
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• In the Termination box, click the arrow, and then select Through All. 

• Select the Tapped Hole type. 

 

• In Thread Type, select ANSI Metric M Profile. 

• Ensure that Full Depth is checked. 

• From the Size drop-down list, select 16. 

• From the Designation drop-down list, select M16x1.5. 

 

• Click OK to generate the threaded hole. 
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4. On the File menu > Save Copy As using the class file-naming convention.  
 
In this exercise, you added drilled and tapped holes to the cylinder head.  
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Exercise 2 - Create Threads 

Use the Thread tool to create custom threads on mating faces of a plastic bottle and cap. 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Add Threads 

1. Open inv_unit5_02.iam.  
 

 

2. Zoom in to the top of the bottle. 
 
 

 

3. In the graphics window or browser, select the cap, and then right-click and turn off 
visibility.  

4. In the browser, double-click inv_unit5_bottle:1 to activate edit mode. 

5. On the Part Features panel bar, click Thread.  
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• On the Location tab, ensure that Display in Model and Full Length are checked.  

 

6. Select the split surface as shown. 
 

 

7. Select the Specification tab. 

• From the Thread Type drop-down menu, select ANSI Metric M Profile. 

• From the Designation drop-down menu, select M28x1.5, and then click OK.  
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Tip: You can temporarily change the part color to view the threads more easily. 

Thread the Cap 

1. In the browser, right-click inv_unit5_bottle:1, and then select Visibility to hide the bottle.  

2. Double-click inv_unit5_cap:1 to activate edit mode.  
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3. On the Standard toolbar, click Zoom All to display the cap.  
 

 

4. On the Part Features panel bar, click Thread.  

• On the Location tab, ensure that Display in Model and Full Length are checked. 

• Select the cap's inside surface as shown. 

 

• Click OK. 

 

5. On the Standard toolbar, click Return twice to view the complete assembly. You may 
have to zoom out to view the bottle and cap.  

6. On the File menu > Save Copy As using the class file-naming convention.  
 
In this exercise, you used the Thread tool to create custom threads on mating faces of a 
plastic bottle and cap.  
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Exercise 3 - Create Chamfers and Fillets 

Create chamfer and fillet features on the shaft socket bracket model.  

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Add Chamfers 

1. Open inv_unit5_03.ipt.  
 

 

2. On the Part Features panel, click Chamfer. 

• Select the four vertical edges of the base.  

 
Tip: To select the back edge, press and hold the F4 key, and then rotate the model to view 
hidden edges. Release the F4 key, select the edge, and then press F5 to return to the 
previous view. 

• In the method section of the dialog box, the Distance option is the default. 
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• For distance, enter 10. 

• Click OK. The chamfers are added to the model. 

 

3. On the Part Features panel, click Chamfer. 

• Select the top edges of the three holes. 

• For distance, enter 1. 

• Click OK. The chamfers are added to the model. 
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4. On the Features toolbar, click Chamfer. 

• In the Chamfer dialog box, select the Two Distances option. 

 

• Select the edge as shown. 

 

• For Distance 1, enter 14. For Distance 2, enter 18. 
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• Click the Flip direction button to see how the preview changes when the 
distances are switched. 

• Click the direction button again to return to the original settings. 

• Click OK to create the chamfer feature. 

 

5. Repeat this process to add the same size chamfer to the other side of the part. 
 

 

Add Fillets 

1. On the Part Features panel bar, click Fillet. 

• On the chamfer, select the two short edges as shown. 
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• Press and hold F4, and then rotate the part and select the two edges on the other 
side. 

• In the Fillet dialog box, for the Radius value, enter 16. 

 

• Click OK to add the fillet features. 

 

2. On the Part Features panel bar, click Fillet. 

• On the front of the rib, select the two horizontal edges. 
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• In the Fillet dialog box, for the radius value, enter 30. 

• In Edges and Radius, click Click to add. 

• Select the two horizontal edges. 

 

• For the Radius value, enter 22. 

• In Edges and Radius, click Click to add to create a third selection set. 

• Rotate the model and on the back face directly opposite the second selection set, 
select the horizontal edge. 

 

• For the radius value, enter 10, and then click OK to add the fillet feature. 
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3. On the Part Features panel bar, click Fillet. 

• Click Full Round Fillet. 

 

• Select the face for the first side as shown. 
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• Select the center face as shown. 

 

• Select the face for the second side as shown. 

 

• Click OK. The fillet is created based on the width of the part. 

4. On the Part Features panel bar, click Fillet. 

• Select the three edges where the rib meets the cylinder at the top of the part. 

• In the Fillet dialog box, for the radius value, enter 2. 

• Click OK to add the fillet feature. 
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5. On the Part Features panel bar, click Fillet. 

• Select the edges around the rib and the vertical edge around the rib. There are 15 
edges in the selection set. 

 

• In the Fillet dialog box, for the radius value, enter 2. 

• Click OK. 
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6. On the Part Features panel bar, click Fillet. 

• Select the top edges around the base, the vertical edges on the back plate, and the 
front edges of the rib. There are 61 edges in the selection set. 

Note: You must select the small front edge at the rib/base intersection. 
 

 

• In the Fillet dialog box, for the radius value, enter 2. 

• Click OK. 
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Note: The workflow for this part of the exercise added the fillets (concave edges) first, and 
then the rounds (convex edges). 

7. On the File menu > Save Copy As using the class file-naming convention.  
 
In this exercise, you added placed features to a part. The features included chamfers and 
fillets.  
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Summary/Questions of Placed Features 

Summary 

In this lesson, you learned to: 

• Create hole features. 
• Create thread features. 
• Create chamfers. 
• Create fillets. 

 

Questions 

1. Hole features can only be placed on a part if a hole center point is created using the 
Point, Hole Center tool. 

a. True 

b. False 

2. A fillet created on a convex edge is defined as a round. 

a. True 

b. False 

3. The Hole tool can be used to create the following hole types: 

a. Drilled 

b. Counterbore 

c. Countersink 

d. All of the above 
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Lesson 2 - Create a Lofted Feature; and Emboss, 
Engrave, and Apply Decals to a Model 

In this lesson, you create complex shapes using lofted features. You complete the design 
using embossed, engraved, and decal features. 
 

 

Exercises 

• Create Loft Features 

• Create Emboss and Engrave Features 

• Apply Decals to a Model  

Standards 

This lesson meets standards for Science Content, Math, Language Arts, and Technology. 

Key Terms 

emboss decal 

engrave loft 

Evaluation 

Evaluate students on the completion of the exercises.  
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Resources 

Exercises 

Autodesk Inventor web page 

Procedure 

1. Review the Loft, Emboss, and Decal tools. (Demonstration) 
 
2. Complete Exercise: Create Loft Features. (Student) 
 
3. Complete Exercise: Create Embossed and Engraved Features. (Student) 
 
4. Complete Exercise: Apply Decals to a Model. (Student) 
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Exercise 1 - Create Loft Features 

In this exercise, you create work planes for loft section profiles. You then use loft options to 
define the shape of a razor handle. 

The completed exercise is as shown. 

 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Create a Sketch Point 

1. Open inv_unit5_04.ipt.  
 

 

2. In the browser, double-click Sketch1 to edit the sketch, and then use the Look At tool to 
set up a view normal to the sketch. 

3. On the 2D Sketch Panel, click Point, Center Point, and then create a point coincident 
with the spline near the bottom of the curve (make sure the coincident glyph is displayed as 
you place the point). 
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4. Click Line. 

5. On the Standard toolbar, click Construction. 

6. Draw construction lines coincident with the sketched point and the spline points on both 
sides. 

 

7. Place an equal constraint between the construction lines to parametrically position the 
sketched point midway between the spline points.  

 

8. Change the 120 mm dimension to 130 mm and verify that the sketched point moves 
along the spline to maintain its position midway between the spline points. 
 

 

9. Click Return to finish editing the sketch.  

10. Restore the Isometric view.  
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Create a Work Plane from a Sketched Point 

1. Click Work Plane.  

2. Select the sketched point you just created, and then select the spline (at any point that is 
not close to either construction line) to create the work plane perpendicular to the spline. 
 

 

Create an Ellipse 

1. On the Standard toolbar, click Sketch, and then click the work plane.  

2. Click Project Geometry, and then select the sketched point.  

3. Click the down arrow on the Circle tool, click Ellipse, and then draw an ellipse with 
its center coincident with the projected point and the second point horizontally constrained 
with the center. 
 

 

4. Click General Dimension, and then add a dimension of 9 mm to the major axis, and 
4 mm to the minor axis.  

Note: To dimension an axis, click the ellipse and drag the dimension. 

© 2008 Autodesk, Inc.  104 



Autodesk Design Academy 2008  Pre-Mechanical Engineering 

5. Click Return to finish the sketch. 
 

 

Create a Work Plane on a Spline Point 

1. Click Work Plane.  

2. Select the spline's right endpoint, and then select the spline to create the work plane 
perpendicular to the spline curve. 
 

 

Create a Circular Loft Profile Section 

1. On the Standard toolbar, click Sketch, and then click the work plane.  

2. Click Project Geometry, and then select the sketched point.  

3. Click Center Point Circle, and then draw a circle coincident with the projected point.  
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4. Click General Dimension, and then create a 7 mm dimension to control the 
diameter. 
 

 

5. Click Return to finish the sketch.  

Create a Loft 

1. Click Loft.  

• For the first section, select the concave 3D face as shown.  

 

• Select the other four profile sections in order. 
• Click OK when the preview resembles the image as shown. 
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• In the browser, turn off the visibility of Sketch1 and all four work planes, and then 
use Rotate and other view tools to examine the loft feature.  

 

5. On the File menu > Save Copy As using the class file-naming convention. 
 
In this exercise, you created a loft feature through section profiles.  
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Exercise 2 - Create Emboss and Engrave Features 

In this exercise, you emboss and engrave sketched profile objects on faces of a razor handle 
model. You then create a sketch text object, and engrave it on the handle. 

The completed exercise is as shown in the figure below. 

 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Engrave a Profile 

1. Open inv_unit5_05.ipt.  
 

 

2. Use the Rotate and Zoom tools to examine the part, and then turn on visibility of 
Sketch11 and rotate the view to display the top triangular face. 
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3. Click Emboss.  

• The profile is automatically selected.  

• In the Emboss dialog box, select Engrave from Face option.  

• In Depth, enter 0.9 mm. 

• Click Top Face Color and select Aluminum (Polished) from the Color dialog box drop-
down list.  

 

4. Click OK twice to close both dialog boxes and create the engraved feature. 
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Emboss a Profile 

1. Restore the Isometric View and turn on the visibility of Sketch10. 
 

 

2. Click Emboss. 

• Select all six closed profiles. Be sure to select the top and bottom half of the first two 
herringbone profiles (on the left). 

 

• In the Emboss dialog box, make sure the Emboss from Face option is selected, and 
then change the Depth to 0.2 mm. 

 

• Click Top Face Color and choose Rubber (Black) from the Color dialog box drop-down 
list. 

 

• Click OK twice to close both dialog boxes and create the embossed feature. 

 

• Use the Rotate tool to examine the engraved and embossed features. 
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Create Sketch Text 

1. Turn on the visibility of Sketch9, and then double-click Sketch9 to edit. 

2. Use the Look At tool to set up a view normal to the sketch. 
 

 

3. Click Text. 

• Click in an open area below the part and under the left edge of the construction 
rectangle to specify the insertion point and display the Format Text dialog box. 

• Select Center and Middle Justification.  

 

• Select the Italic option. 

• Change the % Stretch value to 120. 

• Click in the text field and enter The SHARP EDGE. 
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4. Double-click The in the text field and change the text size to 2.5 mm.  
 

 

5. Click OK to place the text. 
 

 

6. Draw a diagonal construction line coincident with the top left corner and bottom right 
corner of the text bounding-box.  

7. Place a coincident constraint between the midpoint of diagonal construction lines on the 
text and the razor body. 
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8. Click Return to finish editing the sketch and then restore the Isometric View.  

Engrave a Sketch Object 

1. Click Emboss. 

• For the profile, select the text object. 

• In the Emboss dialog box, select Engrave from Face option, and then change the 
Depth to 0.5 mm. 

• If necessary, click Flip to set the direction arrow downward. 

• Click Top Face Color and choose Black from the Color dialog box drop-down list. 

• Click OK twice to close both dialog boxes and create the engraved feature. 

2. Use the Rotate tool to examine the engraved and embossed features. 

 
 
 

3. On the File menu > Save Copy As using the class file-naming convention. 
 
In this exercise, you embossed and engraved features onto a razor.  
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Exercise 3 - Apply Decals to a Model 

In this exercise, you use face colors to add a knurled texture to a face, use the Decal tool to 
add a decal, and display X-ray ground shadows. 

The completed exercise is as shown. 

 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Create a New Texture 

1. Open inv_unit5_06.iam.  
 

 

2. In the browser, right-click inv_unit5_06-end cap:1, and select Edit. 

3. On the Format menu > click Style and Standard Editor. 

• Click the plus (+) sign to expand the Color list. 

© 2008 Autodesk, Inc.  114 



Autodesk Design Academy 2008  Pre-Mechanical Engineering 

• In the Style Name list, click Aluminum (Flat) to select it. 

• Click New. 

• Rename the new style from Copy of Aluminum (Flat) to Aluminum (Flat) Knurled. 
Click OK. 

• In Texture, click Choose. 

• In the list of images, click the Knurl_1.bmp image. Click OK. 

• Adjust the % Scale slider to approximately 60%. 

• Click Save, and click Done. 

Change the Face Color 

1. Right-click on the cylindrical face of the end cap and select Properties.  
 

 

2. In the Face Properties dialog box, select Aluminum (Flat) Knurled from the list, and then 
click OK to close the dialog box and update the face color.  
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Insert a Bitmap into a Sketch 

1. In the browser, right-click inv_unit5_06-body:1, and click Edit.  

2. Turn on the visibility of the work plane.  

3. Start a new sketch on the work plane. 

4. Use the Look At tool to set up a view normal to the sketch. 

5. Click Insert Image.  

6. Open inv_unit5_06.bmp, click to place it below the flashlight, and then right-click and 
select Done.  
 

 

Resize and Constrain the Image 

1. Click Project Geometry, and then project the left edge of the flashlight body onto 
the sketch.  

2. Resize and rotate the image by dragging the edges of the image and the four corner 
points.  
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Note: Drag the upper right corner point to move the image and the lower right to rotate the 
image. 

3. Add a horizontal constraint between the midpoint of the projected edge and the midpoint 
of the top edge of the image.  
 

 

4. Add a parallel constraint between the top edge of the image and the projected edge to 
orient the image vertically.  

5. Add a 1.5 mm dimension between the image and the projected edge.  
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6. Add a 50 mm dimension to the image to constrain its size.  
 

 

7. Finish the sketch, and then view the model as an isometric view.  

Create the Decal 

1. Click Decal.  

• Click the image.  

• Click the large cylindrical face of the flashlight body. 

• In the Decal dialog box, check Wrap to Face. 

• Click OK. 

2. Turn off the visibility of the work plane.  
 

 

3. On the Standard toolbar, click Return twice to return to the assembly.  
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Change the Transparency of the Decal 

1. In the browser, right-click inv_unit5_06-body:1, and click Edit.  

2. Right-click Decal1, and click Edit Sketch.  
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3. Expand the sketch entry, right-click the image entry, and click Properties.  
 

 

• In Transparency, check Use Mask to make the background transparent. 

• Click OK to close the dialog box and update the image. 

4. Finish the sketch.  

Note: To make portions of an image transparent, set the lower right corner pixel to the 
same color as the areas that you want to be transparent. In this example, the lower right 
corner pixel is white, so all white pixels in the image are transparent. 
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Display Ground Shadows 

1. Return to the assembly.  

2. On the Standard toolbar, click the down arrow on the Shadow tool, and then click 
X-Ray Ground Shadow.  

3. Rotate the model and notice how the shadow display updates.  
 

 

4. On the File menu > Save Copy As using the class file-naming convention.  
 
In this exercise, you added colors to a face, and a decal to the flashlight.  
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Summary/Questions of Placed Features 

Summary 

In this lesson, you learned to: 

• Create loft features. 
• Create embossed and engraved features. 
• Apply decals to a model. 

 

Questions 

1. A loft blends multiple profiles with varying shapes on separate planar or nonplanar faces 
or work planes.  

a. True 

b. False 

2. To create a raised feature on a part, use the engrave option of the Emboss/Engrave tool. 

a. True 

b. False 

3. To apply a decal to a part model, which image type should be used? 

a. PNG 

b. BMP 

c. GIF 

d. JPG 
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Unit 6 - Document a Part in Autodesk Inventor 

Introduction 

A documented model is a tool to communicate engineering designs to manufacturing, 
purchasing, and service companies. 

Each company has standards for drawing content based on the type of product and the 
company's established internal processes. 
 
The appearance of a drawing varies depending on when, where, and by whom it is 
produced. However, the workflow for creating a drawing is well defined. Drawing creation 
consists of four basic stages:  

• Formatting 
• Creating views 
• Adding annotations 
• Printing and plotting 

 

About this Unit 

You will use Autodesk Inventor® Professional as you progress through the documentation of 
a design.  

In this unit, the focus is on developing an effective workflow as you become familiar with 
the drawing environment. 

Lessons 

• Standard Drawings 

• Annotation 
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Lesson 1 - Standard Drawings 

The typical workflow in Autodesk Inventor produces a 3D model of the design. This data can 
be exported in various file formats for use in downstream applications such as 
manufacturing or rapid-prototyping. 

In addition to this workflow, drawings can be quickly created in Autodesk Inventor's drawing 
environment. This standards-driven environment makes it easy to produce multiview 
orthographics, pictorial, section, and detail views. 

In addition, you create multiple views of an existing part, and in the following lesson, you 
complete the drawing by adding dimensions and text. 

Exercises 

• Create Multiview Orthographic Drawings 

Standards 

This lesson meets standards for Science Content, Math, Language Arts, and Technology. 

Key Terms 

ANSI drawing zones standards 

border ISO title block 

drawing resources sheet   

Evaluation 

You evaluate students on the completion of the exercises.  

Resources 

Exercises 

Autodesk Inventor web page 

Procedure 

1. Start a new drawing. (Demonstration) 
 
2. Review the Autodesk Inventor drawing environment. (Demonstration) 
 
3. Create a view. (Demonstration and student practice)  
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4. Create projected views. (Demonstration and student practice)  
 
5. Complete Exercise: Create Multiview Orthographic Drawings. (Student) 
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Exercise 1 - Create Multiview Orthographic 
Drawings 

Create an independent view to serve as the base view, and then project from the base view 
to create a multiview orthographic drawing. Then, you add an isometric view to the 
drawing.  

 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Create the Views 

1. Open inv_unit6_01.idw. The drawing file contains a single sheet with a border and title 
block.  

2. On the Drawing Views panel, click Base View. The Drawing View dialog box is 
displayed.  

3. Click Explore directories, and then double-click inv_unit6_01.ipt to use it as your 
view source.  

4. In the Orientation list, select Front (XY).  

• In Style, select Hidden Line. 

• Set the Scale to 1. 

• Click the Display Options tab and ensure that All Model Dimensions is not checked. 
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5. Position the view preview in the lower left corner of the sheet (in Zone C6). Click the 
sheet to place the view.  

6. On the Drawing Views panel, click Projected View.  

• Click the base view and move the cursor vertically to a point above the base view. 

• In Zone E6, click the sheet to place the top view. 

• Move the cursor to the right of the base view. 

• In Zone C2, click the sheet to place the right side view. 

• Right-click in the graphics window, and then select Create. 

 

Edit the View 

A scale of 1:1 results in crowded views. In the following steps, you set the base view scale 
to 1:2. The dependent views update automatically.  

1. Move the cursor into the base view to display the red border, and then right-click and 
select Edit View. The Drawing View dialog box is displayed.  
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2. In the Scale list, select 1/2. Click OK.  
 

 
 
The views update to the revised scale.  

3. In the browser, expand the hierarchy of ANSI - Large.  

4. Double-click Field Text. 
 

 

5. In the Edit Property Fields dialog box, scroll down to SCALE.  

6. Click the 1:1 field, and then enter 1:2 for the scale. 
 

 

7. Click OK. The title block updates to the revised scale.  
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Create the Isometric 

Create an isometric view to complete the multiview layout.  

1. On the Drawing Views panel, click Projected View.  

• Select the base view. 

• Move the cursor to a point above and to the right of the base view. 

• In Zone E3, click the sheet to place the isometric view. 

• Right-click the sheet and select Create. 

 

2. Right-click the isometric view, then select Edit View. 

• In Style, click Shaded. 

• Click the Display Options tab, and then clear the check box for Tangent Edges. 

• Click OK. 

3. Click and drag the red border of the right side view and drag it to Zone C4.  
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4. Click and drag the red border of the isometric view and drag it to Zone E4.  
 

 

Create the Section View 

Create section, detail, and auxiliary views based on existing orthographic views.  

1. On the Standard toolbar, click Zoom Window. Create a window around the top view.  

2. On the Drawing Views panel, click Section View.  

• Click inside the top view, and then define the projection line. 

• Place the cursor over the midpoint of the left edge of the part (A'), and then move 
the cursor to extend the projection line away from the part (A). Click to place the 
start point of the section line. 

 

• Drag horizontally past the center of the part (B). Click to define the first segment of 
the section line. 

• Drag the cursor to create an inferred constraint along the slot center (C'). 
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• Drag horizontally until a perpendicular constraint appears (C). Click to define the 
second segment of the section line. 

 

• Drag horizontally to the right of the part (D). 

 

• Click to create the last segment of the section line. Right-click, and then select 
Continue. 

3. The Section View dialog box is displayed.  
 

 

• Zoom out and drag the section preview down to Zone D6. 

• Click to place the view. 
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4. The transition in the offset cutting plane is displayed in the section view.  

To suppress the display of this edge, select it, right-click, and then select Visibility to toggle 
off the display. 

 

Create the Auxiliary View 

An auxiliary view is required to document the features on the inclined face.  

1. On the Drawing Views panel bar, click Auxiliary View.  

2. Click the front view. The Auxiliary View dialog box displays. Select the edge that defines 
the auxiliary projection.  
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3. In Style, click Hidden Line Removed.  
 

 

4. Move the preview down and to the left. In Zone B7, click the sheet to place the auxiliary 
view.  
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Create the Detail View 

Create a detail view to show a portion of the parent view at a larger scale.  

1. Zoom into the top view.  

2. On the Drawing Views panel, click Detail View. Select the top view. The Detail View 
dialog box is displayed.  
 

 

3. Under Fence Shape, click Rectangular  

• Click to place the center of the detail, and then move the cursor. This expands the 
rectangle that defines the view. 

• Click to define the detail boundary. 
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4. Zoom out, drag the preview to the left of the top view, and then click to place the detail 
view.  
 

 

5. On the File menu > Save Copy As using the class file-naming convention.  
 
You created orthographic views of a mechanical part, and then you created section, 
auxiliary, and detail views.  
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Lesson 2 - Annotation 

Working drawings must have a complete set of views for visualization. In addition, they 
must have dimensions and annotation that specifies information such as material and 
quantity required. 

In this lesson, you get model dimensions, add text, centerlines, center marks, and complete 
the title block. 

Exercises 

• Add Dimensions and Annotations 

Standards 

This lesson meets standards for Science Content, Math, Language Arts, and Technology. 

Key Terms 

ANSI drawing zones standards 

border ISO title block 

drawing resources sheet   

Evaluation 

You evaluate students on the completion of the exercises.  

Resources 

Exercises 
Autodesk Inventor web page www.autodesk.com\inventor 

Procedure 

1. Start a new drawing. (Demonstration) 
 
2. Review the Autodesk Inventor drawing environment. (Demonstration) 
 
3. Complete Exercise: Add Dimensions and Annotations. (Student) 
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Exercise 1 - Add Dimensions and Annotations 

You add dimensions and annotations to a drawing of a clamp. The clamp is used to hold a 
work piece in position during machining operations. 

You use model dimensions and drawing dimensions to document feature size.  

 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Add Model Dimensions 

1. Open inv_unit6_02.idw.  
 

 

2. Zoom in on the front view.  

3. Right-click the front view, and then select Retrieve Dimensions. 
 
Note: Model dimensions are the values placed during the creation of the sketch. 
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• Click Select Dimensions. 

• Click all dimensions except the 40.0, 45.0, 17.0, 16.0, and 13.0 dimensions as 
shown in the following. 

 

• Click OK.  

 

Reposition the Model Dimensions 

1. Drag the dimensions to reposition them around the part. A centerline is displayed to help 
you align the dimensions.  
 

 

2. Pan to display the top view.  

3. Right-click the top view, and then select Retrieve Dimensions.  
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• Click Select Dimensions. 

• Click the 17.0, R9.0, diameter 16, and 15 degree dimensions.  

 

• Click OK.  

 

4. Drag the dimensions to reposition them around the part.  
 

 

Add Centerlines and Center Marks 

You add centerlines and center marks to assist in the placement of drawing dimensions.  

1. Right-click on a blank area of the panel bar, and then select Drawing Annotation Panel.  

2. On the Drawing Annotation panel, click Center Mark.  
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3. Click the outer circle of the boss and the two arcs of the slot.  
 

 

4. Pan to display the front view.  
 

 

5. On the Drawing Annotation panel, click the arrow next to the active center mark 
button, and then select Centerline Bisector.  

6. Select the two hidden lines that represent the drilled hole through the boss.  
 

 

7. Pan to display the right side view.  
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8. Select the two hidden lines that represent the drilled hole through the boss.  
 

 

Complete the Title Block 

You use drawing properties to complete the title block information.  

1. Click File menu > iProperties. The drawing Properties dialog box displays.  

2. Click the Summary tab.  

3. In the Author field, enter your name.  
 

 

4. Click the Status tab, and then click the Checked Date DOWN ARROW. From the Checked 
Date list, select the current date.  
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5. In the Checked By field, enter your initials.  

6. Click OK. The title block updates.  
 

 
 
Note: The drawing is not fully documented. Try using the General Dimension tool and Text 
tool to complete the drawing.  

7. On the File menu > Save Copy As using the class file-naming convention.  
 
You retrieved model dimensions on the part, and then repositioned the dimensions. You also 
added centerlines, center marks, and updated the title block. 
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Summary/Questions of Documenting the Assembly 

Summary 

In this lesson, you learned to: 

• Create orthographic multiviews of a mechanical part. 
• Create a section view. 
• Create an auxiliary view. 
• Create a detail view. 
• Add dimensions to a drawing. 

Questions 

1. The ANSI, BSI, DIN, GB, ISO, and JIS drafting standards are preset and cannot be 
edited. 

a. True 

b. False 

2. To create an A3 sheet in a new drawing you would: 

a. Use the Standard (A3) template to create a new drawing. 

b. Sketch a 297 x 412 mm rectangle, and then select Create Sheet. 

c. From the browser Drawing Resources, insert the A3 border. 

d. Edit the sheet and select A3. 

3. The default border will automatically adjust its size and labeling if the sheet is resized. 

a. True 

b. False 

4. The base view sets the initial scale for all dependent views, except for: 

a. Auxiliary views 

b. Detail views 

c. Isometric views 

d. Section views 
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Unit 7 - Assembly Modeling in Autodesk Inventor 

Introduction 

In assembly modeling, parts and subassemblies are combined to form an assembly that 
functions as a single unit. Parts and subassemblies are related to one another by assembly 
constraints. 
 
Assembly constraints determine how components in the assembly fit together. As assembly 
constraints are applied, degrees of freedom are removed, restricting the ways components 
can move.  

About this Unit 

You will use Autodesk Inventor® Professional as you progress through the placement of 
assembly constraints.  

In this unit, the focus is on developing an effective workflow as you become familiar with 
the assembly environment. 

 

Lessons 

• Assembly Constraints 

• Content Center and Design Accelerator 
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Lesson 1 - Assembly Constraints 

Using Autodesk Inventor, you place existing components in an assembly, or create 
components in-place in assembly files.  

Changes made to external components automatically reflect in assembly models and the 
drawings you use to document them. 
 
Assembly constraints define how the components in an assembly relate to one another. For 
example, you can force two planes on separate parts to mate, or specify that a hole and a 
bolt always remain concentric. 
 
These constraints bind your assembly model together. You use Autodesk Inventor to adjust 
the model as its component definitions are modified. 

 

Exercises 

• Apply Assembly Constraints 

• Assemble a Lift Mechanism  

Standards 

This lesson meets standards for Science Content, Math, Language Arts, and Technology. 

Key Terms 

angle constraint component middle out 

assembly flush constraint tangent constraint 

assembly constraints insert constraint top down  

bottom up mate constraint   

Evaluation 

You evaluate students on the completion of the exercises.  
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Resources 

Exercises 

Autodesk Inventor web page 

Procedure 

1. Start a new assembly file. (Demonstration) 
 
2. Place and create components in the assembly. (Demonstration) 
 
3. Apply assembly constraints. (Demonstration) 
 
4. Complete Exercise: Apply Assembly Constraints. (Student) 
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Exercise 1 - Apply Assembly Constraints 

In this exercise, you open an existing assembly file, and then review the mate/flush, angle, 
tangent, and insert constraint types.  

 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Apply Assembly Constraints 

1. Open inv_unit7_01.iam.  
 

 

2. On the Assembly panel, click Place Component. 
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• In the Open dialog box, select inv_unit7_cylinder.ipt, and click Open. 

• Click in the graphics window to place a cylinder, and then right-click and select Done. 

 

 

 

3. On the Assembly panel, Place Component. 

• In the Open dialog box, select inv_unit7_sphere.ipt, and click Open. 

• Click in the graphics window to place a sphere, and then right-click and select Done. 

 

 

 

Apply a Mate Constraint 

1. On the Assembly panel, click Constraint.  
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2. On the Assembly tab, in the Type area, select Mate.  

• Make sure the check mark is removed from Predict Offset and Orientation.  

 

• Select the top edge on one block. 

 

• Select the top edge on the other block. 

 

• Click Apply. 
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3. On the Assembly tab, in the Solution area, select Flush.  
 

 

• Select the front face on one block. 

• Select the front face on the other block. 

 

• Click OK. 
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Apply an Angle Constraint 

1. Click the front block, and then try to drag the block. The grounded symbol is displayed. 
This indicates that this is the grounded component and cannot be moved.  
 
Tip: In the browser, grounded components are displayed with a thumbtack icon. 
 

 

2. Click the back block, and then try to drag the block. The part is free to move. The mate 
and flush constraints act like a hinge.  
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3. Drag the block to the approximate angle as shown. 
 

 

Tip: If the sphere and cylinder interfere with the blocks, drag them away from the blocks.  

4. On the Assembly panel, click Constraint.  

5. On the Assembly tab, in the Type area, select Angle.  

• Place a check mark in Predict Offset and Orientation.  

 

• In Solution, select Undirected Angle.  
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• Select the top face on one block. 

 

• Select the top face on the other block. The current value of the angle constraint is 
displayed. 
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• In Angle, enter 45. 

• Click Apply. 

• Click Cancel. 

 

 

Apply a Tangent Constraint 

1. In the browser, expand inv_unit6_block:2, right-click Work Axis1, and then select 
Visibility.  

2. In the browser, expand inv_unit7_sphere:1, expand the Origin folder, right-click Y Axis, 
and then select Visibility. 
 

 

3. On the Assembly panel, click Constraint.  

• Remove the check mark in Predict Offset and Orientation. 
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• Select the work axis on the block. 

 

• In the browser, select Y Axis on inv_unit7_sphere:1. It is easier to select in the 
browser, since the axis is not visible on the shaded display. 

• Click Apply. 

• Click Cancel. 

 

 
 
Note: The sphere in your assembly may not be in the same location shown in the image. To 
make the next step easier, you move the sphere.  
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4. Drag the sphere outside of the block. 
 

 

5. On the Assembly panel, click Constraint.  

• On the Assembly tab, in the Type area, select Tangent. 

• In Solution, select Inside.  

 

• Select the sphere. 

• Select the chamfered face on the top block. 
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• Click Apply.  

 

• Click Cancel.  

Use Alt-Drag 

1. Hold down the ALT key and move the cursor over the edge of the cylinder, and then drag 
the part. An arrow is displayed at the center of the cylinder and the Insert constraint symbol 
is displayed.  

• Release the ALT key. 

 

• On the keyboard, press M to change to a mate constraint. A centerline is displayed 
and the symbol changes to a mate constraint. 
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• Drag the cylinder over the hole and place it into the hole just as you would assemble 
the model. Both centerlines are displayed for the correct solution. 

• Release the mouse button to place the part.  

 
 
Note: If the Select Other tool is displayed before you release the mouse, click the center 
dot on the Select Other tool to place the part.  

2. Drag the cylinder up and down. The cylinder is free to move vertically along its axis.  

3. On the browser, click the arrow next to Assembly View and select Modeling View.  
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4. Next to Constraints, click the plus (+) sign. All constraints in the assembly are displayed.  
 

 

5. In the list, right-click the last Mate constraint, and then click Delete.  
 

 

6. Drag the cylinder away from the block.  
 

 

Apply an Insert Constraint 

1. On the Assembly panel, click Constraint.  
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2. On the Assembly tab, in the Type area, select Insert.  

• Select the top edge of the hole.  

 

• Select the top outside diameter edge on the cylinder.  

 

• In Solution, select Aligned. 

 

• Click OK.  
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3. Click the cylinder, and then drag the mouse up and down. The cylinder cannot move 
vertically.  

4. Click View menu > Degrees of Freedom. The cylinder has one rotational degree of 
freedom displayed.  
 

 

5. On the File menu > Save Copy As using the class file-naming convention.  
 
You opened an existing assembly file, and then applied mate/flush, angle, tangent, and 
insert constraint types.  
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Exercise 2 - Assemble a Lift Mechanism 

In this exercise, you place components in an existing assembly and assemble the lift 
mechanism. 

The completed exercise is as shown. 

 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Open the Assembly 

1. Open inv_unit7_02.iam. 
 

 

2. In the browser, double-click LinkRod:1 to activate the subassembly. 
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3. Zoom in to the rod end. 
 

 

Constrain the Rod End 

1. In the Assembly panel, click Constraint. 

• In the Place Constraint dialog box, ensure that Show Preview is selected.  

 

• In Type, click Insert to select an Insert constraint. 

• Move the cursor over the top of the threaded section until the arc is highlighted, and 
then click to select the arc. 

 

• Rotate your view so you can see the end of the rod. Do not close the Place 
Constraint dialog box. 
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• Move the cursor over the edge of the hole in the rod, and then click when the edge is 
highlighted. 

• Click Apply. Do not close the Place Constraint dialog box. 

 

2. Zoom out to view the entire link rod assembly. 
 

 

• In the Place Constraints dialog box, click Angle to select an angle constraint. 

• Make sure the Angle is 0 degrees. 

• Click the face of each rod end. 
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• Click Apply. 

• Click Cancel to close the Place Constraint dialog box. 

Change the Insert Offset 

The top rod end is assembled tight into the rod. The end should extend out 7 mm. 

1. In the browser, expand End_Male:1. 

• Right-click on the insert constraint, and select Modify. 

• In the Edit Dimension dialog box, enter 7 mm and then click the check mark. 

The rod end moves out 7 mm. 

 

2. On the Standard toolbar, click Return to return to the main assembly. 

Note: Although the link rod is an assembly, it is treated as a single component at the main 
assembly level. 

Assemble the Connector and Sleeve 

1. Right-click in the graphics window, select Isometric View, and then zoom in on the small 
connector and sleeve. 

2. Drag the connector so the small end is near the sleeve. 
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3. In the Assembly panel, click Constraint. Mate is the default constraint.  

• Move the cursor over the hole in the arm on the sleeve, and then click when the 
centerline displays. 

 

Note: Use the Select Other tool to cycle through the available choices. 

• Move the cursor over the hole in the link, and then click when the centerline is 
displayed. 

 

• Click Apply. 

© 2008 Autodesk, Inc.  166 



Autodesk Design Academy 2008  Pre-Mechanical Engineering 

Add a Mate Constraint Between Faces 

1. Click the small flat face on the ball in the link end. 
 

 

• Click the inner face of the slot on the sleeve.  

 

• Click Apply. 

 

• Click Cancel to close the Place Constraint dialog box. 
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• Click on the small link arm and drag it to view the effect of the two constraints. 

Place the Crank in the Assembly 

1. In the Assembly panel, click Place Component. 

• Open Crank.ipt.  

• Move the component near the spyder arm, click to place the part, and then right-
click and select Done. 

 

Constrain the Crank 

1. In the Assembly panel, click Place Constraint. 

• Move the cursor over the hole in the arm on the crank, and then click when the 
centerline is displayed. 

 

• Move the cursor over the hole in the spyder, and then click when the centerline is 
displayed. 
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• Click Apply. 

 

• Click Cancel to close the Place Constraint dialog box. 

• Rotate and drag the crank away from the spyder arm to make it easier to apply the 
next constraint. 
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2. In the Assembly panel, click Place Constraint.  

• Click the inner face of slot on the crank. 

 

• Rotate the model, and then click the face of the spyder arm. 

 

• Click Apply. 

 

• Click Cancel to close the Place Constraint dialog box. 
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Assemble the Crank and Link 

1. Return to an isometric view. 

• Zoom in to the crank and link. 

• Rotate and move the crank and link to the positions as shown. 

 

2. In the Assembly panel, click Place Constraint. 

• Place a mate constraint between the centerlines of the two holes as shown. 
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• Click Cancel.  

Place a Claw in the Assembly 

1. In the Assembly panel, click Place Component.  

• Open Claw.ipt. 

• Move the component near the end of the spyder arm, click to place the part, and 
then right-click and select Done. 
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Constrain the Claw 

1. In the Assembly panel, click Place Constraint. 

• Place a mate constraint between the centerlines of the holes, and then another 
constraint between the two faces as shown. 

 
 

 

Note: When the centerline mate constraint is applied, the claw will be oriented incorrectly. 
The orientation will be correct when the face-to-face mate is applied. 
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• Click Cancel in the Place Constraint dialog box. 

• Rotate the claw to the position as shown.  

 

• Return to the isometric view. 
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Assemble the Link Rod 

1. Drag the crank, claw, and link rod into the positions as shown. 
 

 

2. In the Assembly panel, click Place Constraint. 

• Assemble the link arm to the claw and crank using mate constraints between 
centerlines at each end and a mate between faces at one end. 

 

3. Close the Place Constraint dialog box.  

4. Drag the claw to view the effect of the assembly constraints. 

5. On the File menu > Save Copy As using the class file-naming convention. 
 
You opened an existing assembly file, placed existing components in the assembly, and then 
assembled the lift mechanism using mate and insert constraint types.  
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Summary/Questions of Assembly Modeling 

Summary 

In this lesson, you learned how to: 

• Place components in an assembly. 
• Apply a mate constraint. 
• Constrain drag a part. 
• Apply a flush constraint. 
• Apply an angle constraint. 
• Apply a tangent constraint. 
• Apply an insert constraint. 

 

Questions 

1. Which assembly constraint has the most options for positioning parts in your assembly? 

a. Mate 

b. Angle 

c. Tangent 

d. Insert 

2. Where are components that are created in the assembly environment saved? 

a. In the assembly file. 

b. In-place parts are saved in the assembly file; in-place subassemblies are 
saved in separate files. 

c. Each part and subassembly is saved in a separate file. 

d. In-place subassemblies are saved in the assembly file; in-place parts are 
saved in separate files. 

3. Assembly motion can be obtained by: 

a. Dragging an unconstrained component or driving the value of a key 
constraint. 

b. Driving the value of a grounded component's angle constraint. 
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c. Dragging a constrained component with one rotational degree of freedom 
and no translational degrees of freedom. 

d. Dragging a constrained component or driving the value of a key constraint. 

4. What motion is possible if an insert assembly constraint is applied between a cylinder and 
a hole? 

a. Rotation about the cylinders's Z-axis only. 

b. Vertical motion along the cylinders's Y-axis. 

c. Horizontal motion about the cylinders's X-axis. 

d. All motion is possible with an insert constraint. 
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Lesson 2 - Content Center and Design Accelerator 

Using Autodesk Inventor, you create parts and assemble them using assembly constraints. 
In addition to parts created during the design process, standard parts such as nuts, bolts, 
and washers are used in an assembly. These standard parts are available from the Content 
Center. 

The Content Center is a tool used for accessing and maintaining the Content Center library. 
It can be used to:  

• Find a part in the Content Center library.  
• Insert a Content Center library part in an assembly.  
• Use the Feature Generator to edit extrude, revolve, and sweep features by dragging 

predefined and customer defined features.  
• Edit Content Center library parts placed in assembly.  
• Change parameters for Content Center library parts, and add or remove parts within 

a part family. The changes are incorporated into the Content Center library.  
• Publish parts, iParts, or features in the Content Center library.  

 

The design process requires numerous calculations. To assist you in this, Autodesk Inventor 
provides the Design Accelerator. Design Accelerator is a knowledge content tool. It provides 
a set of generators and calculators that have the ability to create mechanically correct 
components automatically by entering simple or complex mechanical attributes. There are 
three main sections:  

• Component Generators  
• Mechanical Calculators  
• Engineer's Handbook  
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Exercises 

• Place Standard Parts in an Assembly 

Standards 

This lesson meets standards for Science Content, Math, Language Arts, and Technology. 

Key Terms 

Bolted connection 

Content Center 

Design Accelerator 

Evaluation 

You evaluate students on the completion of the exercises.  

Resources 

Exercises 

Autodesk Inventor web page 
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Procedure 

1. Review the Content Center. (Demonstration) 
 
2. Review Design Accelerator. (Demonstration) 
 
3. Complete Exercise: Place Standard Parts in the Assembly. (Student) 
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Exercise 1 - Place Standard Parts in an Assembly 

In this exercise, you open an existing assembly file, and then add standard parts from the 
Content Center. You also use Design Accelerator to design a bolted connection. To complete 
the assembly, you create a circular pattern.  

 

Note: Autodesk Data Management Server and Content Center must be installed to 
complete this exercise. 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Log In to the Library 

1. Open inv_unit7_03.iam.  
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2. On the Assembly panel, click Place Component from Content Center.  

3. If the Welcome dialog box is displayed, click Log In.  

4. In the Log In dialog box, place a check mark in Content Center library read only user. 
 

 

5. Click OK. 

Use the Content Center 

You can set filters in Content Center to exclude selected international standards, 
manufacturers, or categories of parts from the Content Center view.  

1. In the Place from Content Content dialog box, click the down arrow on the Filters button, 
and then select Add/Edit Filters. 
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• In Filter Group Name, select ISO. 

• Click the Categories tab. 

• Remove all check marks, except for Fasteners. 

 

• Click OK to save changes. 
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2. Under Category View, expand Fasteners > Bolts, and then click Socket Head.  

3. On the Content Center toolbar, ensure that Thumbnail is selected. 
 

 

4. In the List panel on the right, double-click ISO 4762. 

• Right-click on the bolt, and then click Edit the component. 
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• In Thread description, select M8. 

• In Nominal Length, select 35. 

• Click OK.  
• In the graphics window, click to place an occurrence of the bolt. 

• Place three more bolts. 

• Right-click and select Done. 

 

5. On the Assembly panel, click Place Component from Content Center.  

6. Expand Fasteners > Nuts, and then click Hex.  

7. In the List panel on the right, double-click ISO 4032.  

• Right-click on the nut, and then click Edit the component. 

• In Thread description, select M8. 
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• Click OK. 

• Place four nuts. 

• Right-click and select Done. 

 

Assemble the Nuts and Bolts 

1. On the Assembly panel, click Place Constraint.  

2. In Type, select Insert.  

• Select the edge of the hole as shown.  

 

• Select the circular edge on a cap screw as shown.  
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• Click Apply. 

• Use this workflow to assemble the three remaining cap screws.  

Tip: You can also use the Alt-Drag method to assemble the cap screws and nuts. 
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3. Rotate the assembly to view the threaded end of the cap screws. 
 

 

4. On the Assembly tab in the Type area, select Insert.  

• Select the outer edge of the chamfer on the nut as shown.  

 

• Select the circular edge as shown.  
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• Click Apply. 

• Use this workflow to assemble the three remaining nuts.  

 

• Click Cancel. 
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Design a Bolted Connection 

1. View the claw as an isometric view as shown. 
 

 

2. On the Assembly panel, click Bolted Connection Generator. 

• By default, the Through All connection type should be selected. 

 

• In Placement, select By hole. 
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• In Thread, select ANSI Metric M Profile. 

 

• In Diameter, select 8 mm. 

• In Placement, select Start Plane. Select the front plane as shown. 

 

• Select the existing hole as shown. 
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• Rotate the assembly, and then select the termination as shown. 

 

• From the Items list, select Click to add a fastener. 

 

• Scroll down the list, and then select Forged Socket Head Cap Screw - Metric. 
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• From the Items list, select the final Click to add a fastener. 

 

• From the Standard list select ISO, and in the Category list, select Nuts. 

• Scroll down and select ISO 4032. 

• Click OK twice. The bolt and nut are added to the hole. 
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3. Repeat this workflow to design a bolted connection for the second hole on the claw. 

 

Tip: Instead of using Bolted Connection Generator, you can drag the first bolted connection 
from the browser to create a second occurrence, and then use assembly constraints. 

4. Press F6 to return to the isometric view. 

Complete the Assembly 

1. On the Assembly panel, click Pattern Component, and then click the Circular tab. 

• In the browser, select all of the components except the sleeve, spyder, and lift ring. 

• In Circular, click Axis Direction. 
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• Click the face of the spyder arm to select the axis. 

 

• In Circular Count, enter 3. 

• In Circular Angle, enter 120. 

• Click OK. 

• Drag the sleeve up and down to review the assembly. 

• Return the sleeve to the following position. This will provide a working solution for 
the animation.  
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Animate the Assembly 

1. In the browser, expand Sleeve:1. 

• Right-click Drive this constraint, and then select Drive Constraint. 

• In Start, enter 25 mm. 

• In End, enter 50 mm. 

• Click More. 

• In Repetitions, select Start/End/Start. 

• In Repetitions, enter 20. 

• Click Forward to view the simulated motion of the spyder arm assembly. 

• Click Cancel. 

2. On the File menu > Save Copy As using the class file-naming convention.  
 
You opened an existing assembly file, and then added bolts and nuts from the Content 
Center and designed a bolted connection with Design Accelerator. You then completed the 
assembly by creating a circular pattern and simulated the motion of the assembly using 
drive constraints.  
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Summary/Questions of Assembly Modeling 

Summary 

In this lesson, you learned how to: 

• Open an existing assembly file. 
• Add standard parts from the Content Center. 
• Use Design Accelerator to design a bolted connection. 
• Create a circular pattern to complete the assembly. 

Questions 

1. By default, the Content Library installs all international standards, such as ANSI, ISO, 
DIN. 

a. True 

b. False 

2. Within any standard, the best workflow to define which items are excluded from the 
library view and search, is to create a ______________. 

a. Filter 

b. Sieve 

c. Macro 

d. List 

3. To view a pictorial image of content, which option would be selected from the View 
menu? 

a. Details 

b. Thumbnails 

c. List 

d. Icons 

4. Components in the Content Library are read-only. 

a. True 

b. False 
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Unit 8 - Documenting an Assembly 

Introduction 

You can develop exploded views, animations, and other stylized views of an assembly to 
help document your design. Any static presentation view can be used in a drawing.  

You can develop a complete set of standardized drawings for the assembly and all of its 
components in a single drawing file.  

About this Unit 

You will use Autodesk Inventor Professional as you progress through the creation of a 
presentation view and the documenting of an assembly.  

 

Lessons 

• Document an Assembly 
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Lesson 1 - Document Assemblies 

In this lesson, you create a presentation view. 

 

You then document an assembly. 

 

Exercises 

• Create a Presentation View 

• Document an Assembly 
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Standards 

This lesson meets standards for Science Content, Math, Language Arts, and Technology. 

Key Terms 

assembly exploded view 

base view wire 

RefDes   

Evaluation 

Evaluate students on the completion of the exercises.  

Resources 

Exercises 

Autodesk Inventor web page 

Procedure 

1. Review the Cable and Harness module. (Demonstration) 
 
2. Complete Exercise: Create a Presentation View. (Student) 
 
2. Complete Exercise: Document an Assembly. (Student) 
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Exercise 1 - Create Presentation Views 

In this exercise, you create a presentation view of an existing assembly in a new 
presentation file, and then you add tweaks to the assembly components to create an 
exploded view. Trails are automatically created when tweaks are applied to components. As 
all the tweaks follow the same path, there is no need for trails to be displayed for all of the 
components. In this exercise, you display the trails for the first three tweaks you create, 
and then you turn off the display of trails for the remainder of the tweaks.  

 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Create a New Presentation File 

1. On the Standard toolbar, click New. 

• Select the Metric tab, and then double-click Standard (mm).ipn. 

2. Click Create View.  

3. Click Explore Directories.  

• Select Face_Valve_Pump.iam, and then click Open. 
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• If a message box is displayed, click OK. 

• In the Select Assembly dialog box, click Options. 

• In the Design View Representation list, select Internal Components.  

 

• Click OK. 

• In Explosion Method, verify that Manual is selected.  

• Click OK. 
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4. Click the plus (+) sign in front of Explosion1, and the plus (+) sign in front of 
Face_Valve_Pump.iam to expand the display. 
 

 

5. Save your file as Face_Valve_Pump.ipn.  

Add Tweaks to Components 

1. Click Tweak Components.  

• In the Tweak Component dialog box, verify that Direction is selected and Display 
Trails is checked.  

• Position your cursor over a cylindrical face until the temporary Z axis aligns with the 
axis of the assembly, as shown. 
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• Click to accept the axis orientation. 

• Click on the nut at the base of the assembly to select it. Nut_B:1 is highlighted in the 
browser.  

• In Transformations, verify that the Z button is selected, and then enter 40. 
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2. Click Apply to create the tweak. 
 

 

3. In the browser, click ValvePlate:1. Nut_B:1 should be deselected. 

4. In Transformations, enter 20.  

5. Click Apply to create the tweak. 
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Tip: You can also select components by clicking them in the browser. This is useful when 
trying to select hidden components.  

Next, tweak the nut at the top of the assembly. 

6. Click Nut_A:1 in the browser to select it. 

7. In Transformations, enter -115, and then click Apply to create the tweak. You will have 
to zoom out to view the tweak. 
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Tip:  Examine the browser. Expand the components that have a plus (+) sign in front of 
them to view the tweaks you have applied. 

8. Clear the Display Trails check box. 

9. Finish the exercise by adding the following tweaks: 

Part name   Tweak 

WasherB:1   -105 

Pin:1   -85 

Spring:1   -45 

WasherA:1   -30 

Diaphragm:1   -15 

 
Warning:  Make sure the Z axis is aligned through the assembly in the same direction or 
unexpected results will occur. 

10. Close the Tweak Component dialog box when you are finished. 
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Notice that the diaphragm looks slightly out of place. 

Modify the Tweak 

In this section of the exercise, you modify the existing tweak to the component. 

1. In the browser, expand Diaphragm:1 and WasherA:1.  

The hierarchy displays tweaks nested below each component definition. 
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2. In the browser, click Tweak (15.000 mm) under Diaphragm:1. 

The Offset value is displayed at the bottom of the browser. 

3. In the Offset, enter 10, and then press ENTER.  

The diaphragm moves to its new position. 

 
 
Tip:  After you define the tweak axes, you can click and drag a component, or group of 
components, to create a tweak. This way, you can quickly arrange your components 
visually. Later you can edit the values of the tweaks from the browser to define their final 
positions. 

Animate the Presentation 

1. Click Animate.  

• In the Animation dialog box, click Play Forward. 

• When the animation is complete, click Cancel. 

Tip: The Intervals default setting is 25. Enter a lower number to speed up the animation. 

2. Close the file. Do not save changes. 
 
You created a presentation view of an existing assembly in a new presentation file, and then 
you added tweaks to the assembly components to create an exploded view.  
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Exercise 2 - Create an Assembly Drawing 

In this exercise, you create views of an assembly, add balloons and a parts list. You then 
add a new sheet and document parts of the assembly. 
 

 

Create a Base View 

1. Open inv_unit8_face_valve_pump.idw.  

The drawing has a two sheets. The first sheet has no drawings views. On the second sheet, 
views of the parts have already been created. You will review these at the end of the 
exercise. 

2. Click Base View.  

The Drawing View dialog box is displayed. 

3. Click Explore Directories.  

• In the Files of Type drop-down list, select Assembly Files, and then double-click 
Face_Valve_Pump.iam as the view source.  
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• In Orientation, click Change view orientation. 
 

 

• Zoom and rotate to view the top face of the assembly. 

• Click Look At, and then select the flat surface as shown. 
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• Click Exit Custom View. The top view of the assembly is now correctly aligned. 
 

 

• Set the Style to Hidden Line. 

• Set Scale to 1:1. 

• Position the view preview in the upper-left corner of the sheet. Click the sheet when 
you have positioned the view.  
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Create a Sectioned Assembly View 

In the following steps, you create a sectioned assembly view. 

1. In the browser, expand the listing to display the parts. 
 

 

2. In the browser, Select Pump_Pin:1, press and hold CTRL, and then select 
Pump_Spring:1, Pump_Nut_A:1, and Pump_Nut_B:1. Release the CTRL key.  
 

 

3. Right-click any of the highlighted parts in the browser, and then click Section 
Participation > None to remove the check mark.  
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4. Click Section View.  

• Select the top view of the assembly and place a view projection line that divides the 
top view horizontally to create a full section, and then right-click and select Continue. 
 

 
• Move the preview below the top view and click to place the view. Notice that the 

spring, pin, and two nuts are not sectioned. 
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Annotate a View 

1. Click Text. 

• Select a point to the left of the top assembly view. 

• Enter CYLINDER HEAD AND, and press ENTER. Enter SPRING REMOVED, and 
then click OK. 

 

Project a Section View 

1. Click Projected View.  

• Select the sectioned assembly view as the base view.  

• Move the preview up and to the right, and then click the sheet. 

An isometric pictorial view is placed. 

• Right-click and select Create. 
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Insert Balloons 

Leader lines with balloons identify every part in the assembly. The item number in the 
balloon corresponds to the item number in the parts list. 

1. Pan and zoom to display the sectioned assembly view. 

2. Click Balloon.  

• Select the edge of the component as the start of the leader as shown. 

• Click a point on the sheet to define the end of the first leader segment.  

• Right-click, and then select Continue to place the balloon. 
 

 

Instead of placing balloons one at a time, you can use the Auto Balloon tool. 

3. On the Drawing Annotations panel, click Auto Balloon.  

• Select the sectioned view to identify the BOM source. 

• Place a window around the view as shown. 
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• Click Select Placement and Around. 

 

• In the graphics window, click to place the balloons. 

• Click OK. 

• If required, move balloons to improve the layout. 
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Insert the Parts List 

1. Click Parts List. 
 
The Parts List dialog box is displayed.  

• In the graphics window, select the sectioned assembly view.  

• Click OK to create a structured BOM from the view to the parts list.  

The parts list outline is displayed on your cursor. 

•  Move the parts list until it joins the title block and border (indicated by the cursor 
symbols) as shown, and then click to place it.  
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•  Zoom in to display the parts list and title block, as shown. 
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Review the Parts Drawings 

1. In the browser, right-click Sheet2, and then click Activate. 
 
The second sheet is displayed with part drawings of three parts.  

2. Review the browser and the drawings.  

3. Save the file using the class file-naming convention. 
 
You opened an existing drawing file, and then added a base, sectioned, and isometric view. 
You then added balloons and a parts list.  
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Summary/Questions of Documenting Assemblies 

Summary 

In this lesson, you learned to: 

• Create a presentation view. 
• Create a base view. 
• Create a section view. 
• Create a projected isometric view. 
• Add balloons to a view. 
• Create a parts list. 

Questions 

1. What is name of the first view created in a drawing? 

a. Section 

b. Base 

c. Projected 

d. Auxiliary 

2. To exclude parts from a section view, select the part in the browser, then click Section 
Participation > _________. 

3. What is the file extension of a drawing file? 

a. CFG 

b. IAM 

c. IDW 

d. DWG 

4. What is the file extension of a presentation file? 

a. IPN 

b. IPT 

c. IAM 

d. IPJ 
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Unit 9 - Functional Design 

Introduction 

Typical engineering models are a combination of parts, sheet metal casings, electrical 
wiring, and piping. Using the Autodesk Inventor® Professional modules, you can quickly and 
easily:  

• Design virtual models of wiring, cables, and harnesses. 

• Create tubing, piping, and flexible hosing. 

About this Unit 

You will use Autodesk Inventor Professional as you progress through the creation of a wire 
harness and a pipe run.  

In this unit, the focus is on developing an effective workflow as you become familiar with 
the Autodesk Inventor Professional modules. 

 

Lessons 

• Use Cable and Harness 

• Use Tube and Pipe 
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Lesson 1 - Use Cable and Harness 

In this lesson, you add wires manually and import wires using wire lists. 

 

You then create harness segments and route wires through the segments. 

 

Exercises 

• Add Wires 

• Create Segments and Route Wires 

Standards 

This lesson meets standards for Science Content, Math, Language Arts, and Technology. 
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Key Terms 

cable segment 

harness wire 

RefDes   

Evaluation 

Evaluate students on the completion of the exercises.  

Resources 

Exercises 

Autodesk Inventor web page 

Procedure 

1. Review the Cable and Harness module. (Demonstration) 
 
2. Complete Exercise: Add Wires. (Student) 
 
2. Complete Exercise: Create Segments and Route Wires. (Student) 
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Exercise 1 - Add Wires 

In this exercise, you create new wires, add wires manually to connectors, and then import 
wires using a configuration (.cfg) and data file (.csv).  

 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Open the File 

1. Open inv_unit9_01.iam. 
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Select a Design View Representation 

1. In the browser, expand Representations, and then expand View. 

2. Double-click Import wires. 
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Create a Harness Assembly 

1. Click Create Harness.  

• In New Harness Assembly Name, enter ADA Harness.iam. 

• In New Assembly Location, the folder location should be the Unit 9 exercise data 
sets. 

 

• Click OK. The harness assembly is displayed in the browser and is made active. 

 

Create New Library Wires 

1. Click Cable & Harness Library.  

2. Click New.  

• In the Library Wire dialog box, on the General tab, enter or select the following: 

o Name: ADA_EE_18  
o Category: Custom  
o Color Style: Blue  
o Part Number: 715130  
o Outer Diameter: 1.024 mm  
o Gauge: 18 
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• Click the Custom tab, and then enter or select the following: 

o Name: Vendor  
o Type: Text  
o Value: Wirecorp 

• Click Add. 

 

• Click Save to create the wire definition. 

• Create a second new wire as follows: 

o Name: ADA_EE_20  
o Category: Custom  
o Color: Green  
o Part Number: 715162  
o Outer Diameter: 0.813 mm  
o Gauge: 20  
o Enter or select the same Custom properties as the new ADA_EE_18 wire. 
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• Click Save to save the wires to the referenced wire library. 

 

 

• Click Close. 

Create Wires 

1. Click Create Wire.  

The Create Wire dialog box is displayed. The default Wire ID is acceptable for this exercise. 

• From the list of wires, select the wire as follows: 

o Category: Custom  
o Name: ADA_EE_18 
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• Move the cursor over the work point on Pin 1 of Connector1, and then click to select 
the start pin for the wire. 

 

• Move the cursor over the work point on Pin 1 of the part named LTP, and then click 
the end pin for the wire. 

 

Note:  The placeholder reference designators U? and J? will be replaced in the next section 
of the exercise. 

• Click Apply to create the wire. 

• In the Create Wire dialog box, select the ADA_EE_20 wire. 

• Create a second wire starting at Pin 2 on Connector1 and ending at Pin 2 on the LTP 
connector. 
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• Click Cancel. 

Edit the RefDes Properties 

1. In the browser, right-click Connector1:1, and then click Harness Properties. 

2. Enter U3 for RefDes. Click OK. 

3. In the browser, right-click Connector2:1, and then click Harness Properties. 

4. Enter U7 for RefDes. Click OK. 

5. In the browser, expand PCB:1, right-click LTP:1, and then click Harness Properties. 

6. Enter J7 for RefDes. Click OK. 
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View the Data File 

1. In Windows Explorer, in the Unit 6 Pre-Mechanical datasets folder, double-click 
ada_input.csv. The file should open in Microsoft Excel. 

2. Review the file. The data file contains the actual wire data to import into the active 
harness assembly to establish connectivity. 
 

 

3. Close Microsoft Excel. 

Import the Wires 

1. Click Import Harness Data.  

• In Harness Data File (.xml or .csv), click Browse. 

• Change Files of type: to Wire List Data File (*.csv). 

• In the Data File (.csv), click Browse, and then locate, select, and open ada_input.csv 
in the Unit 9 Pre-Mechanical folder. 

• In Configuration File (.cfg), click Browse, and then locate, select, and open 
ada_input.cfg in the Unit 9 Pre-Mechanical folder. 

• In the Import Wire List dialog box, click OK to add the wires to the harness 
assembly, and then click Close on the information dialog box. Zoom out to review 
the imported wires. 
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2. On the Standard toolbar, click Return.  

3. View the assembly as an isometric.  

4. Save the file using the class file-naming convention. 

Note: This file is required for the next exercise, Create Segments and Routes. 

You created wires, added wires manually, and then imported wires.  
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Exercise 2 - Create Segments and Route Wires 

In this exercise, you create harness segments, and then route wires through the segments. 

The completed exercise is as shown. 

 

Note:  You must complete the previous exercise before starting this exercise. 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Open the Assembly  

1. Open inv_unit9_01.iam. The assembly should match the image as shown. 
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Select a Design View Representation 

1. In the browser, expand Representations, and then expand View. 

2. Double-click Import wires. 
 

 

Edit the Harness Assembly 

1. In the browser, right-click ADA Harness, and then click Edit. 
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Create the First Segment 

1. Click Create Segment. 

• Click the work point closest to the front of Connector1 to start the segment. 

 

• Click the second work point in front of Connector1 to continue the segment. 

 

• Zoom and pan to the first tie-down, and then click the work point. 

 

• Click the next work point. 

 

• Continue placing the segment through the tie-down work points. 

© 2008 Autodesk, Inc.  236 



Autodesk Design Academy 2008  Pre-Mechanical Engineering 

 

• Click the work point furthest from Connector2. 

 

• Click the work point closest to Connector2. 

 

• Right-click, and then click Finish. 

 

• Zoom and pan to view the harness segment. 
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Note: In this example, the wire display is set to centerline and the segment is set to 
rendered.  

Add a Segment Branch 

1. Click Create Segment.  

• Zoom into the LTP connector. 

• Click a point on the harness segment near LTP to start a branch. 

 

• Move the cursor over the connector, right-click, and then click Edit Offset. 
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• Enter 5. Click OK. 

 

• Move the cursor over the connector and click to place the endpoint of the segment. 

 

• Right-click, and then select Finish. 
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Route the Wires 

1. Click Route.  

• Select the blue and green wires that connect Connector1 to LTP. 

• Make sure the Single Segment (Manual) check box is clear. 

• Click First Segment, and then select the branch closest to LTP. 

 

• Click the segment to the left as the last segment, click Apply, and then click Cancel. 

 

Automatically Route Wires 

You now use the Automatic Route tool to complete the process. 

1. Click Automatic Route.  

• Select the All Unrouted Wires option. 
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• Click OK. The remaining wires are routed through the harness segment. 

• Right-click, and then click Finish Edit. Review the completed wire harness. 

2. Save the file using the class file-naming convention. 
 
You created segments, routed wires manually, and then routed wires automatically.  
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Summary/Questions of Use Cable and Harness 

Summary 

In this lesson, you learned to: 

• Create wires. 
• Add wires manually. 
• Import wires. 

 

Questions 

1. Wire thickness is defined using two properties. The first is the diameter, what is the 
second property? 

a. Length 

b. Gauge 

c. Color 

d. Company name 

2. A simple text string such as J2 or U3 is used to uniquely identify electrical components. 
This string is known as a _____________________________________. 

3. What is the file extension of the data file used to import wires into an assembly? 

a. CFG 

b. IAM 

c. CSV 

d. XLS 

4. Refer to the image of a Microsoft Excel file shown below. What data is referenced in the 
following cells? 

a. A1 ___________________________ 

b. B1 ___________________________ 

c. C1 ___________________________ 
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d. D1 ___________________________ 
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Lesson 2 - Use Tube and Pipe 

In this exercise, you create a new tube and pipe style for a compression molder. You then 
insert fittings from the Tube and Pipe library and from published components not included in 
the library. When this is complete, you create a simple route and run. 

 

Exercises 

• Create a Simple Route and Run 

Standards 

This lesson meets standards for Science Content, Math, Language Arts, and Technology. 

Key Terms 

iDrop route node 

fitting run 

pipe tube 

route  route 

Evaluation 

Evaluate students on the completion of the exercises.  

Resources 

Exercises 
Autodesk Inventor web page www.autodesk.com\inventor 
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Procedure 

1. Review the Tube and Pipe module. (Demonstration) 
 
2. Complete Exercise: Create a Simple Route and Run. (Student) 
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Exercise 1 - Create a Simple Route and Run 

Create a new tube and pipe style for a compression molder. You then insert fittings from the 
Tube and Pipe library and from published components not included in the library. When this 
is complete, you create a simple route and run. 

 

Note: Change the active project to Autodesk Design Academy.ipj before you start this 
exercise. 

Open an Existing Assembly  

1. Open inv_unit9_02.iam. 
 
The assembly should match the image as shown. 
 

 

Create a Tube & Pipe Subassembly  

1. Click Create Pipe Run. 

• In New File Name, enter ADA Pipe Run.iam. 

• In New File Location, the folder location should be the Unit 9 exercise datasets. 
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• Click OK. The assembly is displayed in the browser and is made active. 

Copy Another Style 

Create a new threaded steel pipe style from an existing style. 

1. On the File menu > Autodesk Data Management Server > Log In.  

2. In the Log In dialog box, place a check mark in Content Center library read only user. 
 

 

3.Click OK. 

4. Click Tube & Pipe Styles. 

5. In the Tube & Pipe Styles dialog box, from the Rigid Pipe with Fittings list, select ISO 
7598/ISO 49 - Threaded Steel Pipe with Iron Fittings. 
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6. Click Copy. A new entry is placed below the original. 
 

 

• Select the copy. 

 

• Right-click the copy, and then select Edit. 

 

• On the General tab > New Name, enter ISO Threaded Steel Pipe 1/2 in. 

• Under Diameter, the Nominal diameter should be 1/2 in, and Schedule ID 16.1.  
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• Click the Rules tab. 

• In Min, enter 40 mm. 

• In Max, enter 10000 mm. 

• In Inc, enter 1 mm. 

 

• Click Save. 

• Click Close. 

• On the Standard toolbar, review the Active Style drop-down list to confirm that the 
new style is listed. 

Note: The Active Style list is located at the right side of the Autodesk Inventor window. You 
may have to expand Autodesk Inventor to locate the list. 
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Place Fittings 

In this section of the exercise, you place additional fittings in the assembly. The fittings are 
placed from the Content Center and from published components not included in the library. 
You also move existing components into a Tube & Pipe run. 
 
At the end of this section, your model should resemble the following image: 
 

 
 

 

Apply a Design View 

1. In the browser, double-click inv_unit9_02.iam. 

• In the Model browser, expand the Representations and View folders to display the 
view representations saved with this assembly. 

• Right-click the Hydraulics view representation, and then click Activate. 

 
 
Tip: You can also double-click the view representation name or icon to activate the 
representation. 
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Place a Fitting 

1. In the browser, expand the Tube & Pipe Runs subassembly. 

2. Double-click Run01. (This number may be different if you have previously worked on this 
assembly.)  

3. Click Place Fitting.  

• Navigate to the Pre-Mechanical Unit 9 folder. 

• Select Hyd-6-6 St-P.ipt, and then click Open. 

The fitting is displayed, attached to the cursor. 

• Reorient your view to match the image as shown. 

 

• Zoom into the location for the fitting.  
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•  Right-click, and then click Connect Fitting. 

•  Click the circular edge of the port on the air-oil pump to connect the fitting to the pump. 

 

• Right-click, and then click Done. 
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Place a Library Fitting 

Place the next fitting, a bushing, from the Content Center. 

1. Click Place Component from Content Center. 

• In the Place from Content Center dialog box, click the down-arrow on the Filters 
button, and then select Add/Edit Filters.  

 

• In Filter Group Name, select ISO. 

• Click the Categories tab. 

• Remove all check marks, except for Tube & Pipe. 
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• Click OK to save changes and close the dialog box. 

• Expand Tube & Pipe > Fittings > Bushings. 

• In Bushings, double-click the ISO 4145 Reducing Bushing N4. 

 

• In the DN1 list, select 1. DN2 is automatically set to 1/2 inch. 
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• Click OK. The fitting is attached to the cursor. 

• Rotate the view to display the location of the fitting.  
• Right-click, and then click Connect Fitting. 

 

• Click the circular edge of the coupling that is attached to the tank. 

 

• Right-click, and then click Done. 
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Reorder the Browser 

Reorder components in the assembly browser to make them part of the Tube & Pipe 
subassembly. 

1. Select Bulkhead-6-6:1, and Bulkhead-6-6:2. 

• Drag and drop the components below the ISO 4145 bushing entry. 

 

• Click Yes to proceed. 

• In the browser, double-click inv_unit9_02.iam. 

• The browser should match the image as shown. 
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Create a Pipe Route 

In this section of the exercise, you create a simple rigid pipe route. You cycle through the 
auto route solutions and populate the route with fittings and pipe segments. 
 
At the end of this section, your model should resemble the image as shown.i 
 

 

1. In the browser, expand the pipe runs subassembly.  

2. Right-click the run node, and then click Edit. This places you in the Tube & Pipe 
environment. 
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To select the tube & pipe style 

1. Click Tube & Pipe Styles.  

• Check that ISO Threaded Steel Pipe 1/2 in is the active style. 

• Click OK. 

Tip:  You can also select ISO Threaded Steel Pipe 1/2 in from the Active Style list on the 
Standard toolbar. 

Place a Route Node  

1. Click New Route.  

2. In the Create New Route dialog box, click OK to accept the default route name.  

3. Click Start or continue route definition.  

• In the graphics screen, move the cursor over the bushing in the tank. The open 
connection point is highlighted. 
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• Click to place a node at the connection point. 

• Pan over to the pump and select the circular edge of the open port at the bottom of 
the pump. 

The route is previewed and the Select Other tool is active. The default route has the 
smallest number of segments. 

• Click an arrow on the Select Other tool to cycle through the route solutions. 

• When the route with three segments is displayed again, click the green rectangle in 
the Select Other tool. 

 

• Right-click, and then click Done. 

• Right-click, and then click Finish Edit to complete the route definition.  

 
 
Note: Pipe Run 1 is now the active subassembly. 
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Populate the Route 

1. Click Populate Route. 
 

 

2. On the Standard toolbar, click Return.  

3. View the assembly as an isometric.  

4. Save the file using the class file-naming convention. 
 
You created a new style, added fittings, and populated a pipe run.  
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Summary/Questions of Use Tube and Pipe 

Summary 

In this lesson, you learned to: 

• Create a new style. 
• Add fittings. 
• Populate a pipe run. 

Questions 

1. In the Tube & Pipe Styles dialog box, what tab would you select to set the segment 
length? 

a. General 

b. Size 

c. Rules 

d. Display 

2. To access the Tube & Pipe library, in the Assembly panel, click 
______________________. 

3. Fittings are placed in an assembly using _________ technology.  

4. What is the name of the points you place along a route? 

a. Intersection 

b. Connection 

c. Work point 

d. Node 
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Projects 

You use Autodesk Inventor in many phases of the design process. These projects illustrate 
how you use Autodesk Inventor in all phases of the process, from conceptual design to 
manufacture. 

 

Exercises 

• Design handle grips for a mini-scooter 

• Design a desktop toy 

• Design a puzzle cube 

• Design a playground 

• Design a cookie cutter 

• Design an improved rack and pinion mechanism 

• Design toy blocks 

• Design a bike carrier 

• Design a replica construction toy 

• Design an underwater exploration vessel 
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Project 1 - Design handle grips for a mini-scooter 

A mini-scooter company has asked you to design handle grips for their new line of mini-
scooters. 
 
The major components of the scooter are designed and available to you as Autodesk 
Inventor parts. A partially complete assembly is also available.  

 

Exercises 

• The design problem 

• The design solution 

Resources 

• Design Basics Exercises 

• Pre-Mechanical Exercises 
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• Related web pages 

• Mini-scooters 

Procedure 

1. Define the design problem 
 
2. Conceptualize the design 
 
3. Design the handle grip components in Autodesk Inventor 
 
4. Assemble the handle grip components in Autodesk Inventor 
 
5. Document the handle grip components in Autodesk Inventor 
 
6. Create a portfolio of the design project 
 
7. Create a prototype model (optional) 

© 2008 Autodesk, Inc.  264 



Autodesk Design Academy 2008  Pre-Mechanical Engineering 

The Design Problem 

Review the requirements for the design of handles for the mini scooter. This includes, 
determining overall dimensions, shape, material and color.  

 

Dimensions 

The handles for the mini scooter must fit the existing handle bar.  

Using Autodesk Inventor you can use a middle-out work flow to establish the dimensions of 
the handles. This work flow uses the existing part as the basis for the new design. 

 
To do this, you open the scooter assembly, then create a new component. Using the Project 
Geometry tool, you can project the outside diameter of the handle bar and use this as the 
basis of your design. 
A design consideration is what should the inside diameter of the handle be relative to the 
handle bar. Should it be the same size, smaller, or larger?  
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Shape 

The shape of the handle can take on many forms. Do you want the shape to be a simple 
cylinder, slightly curved, or have a profile that matches the fingers on your hand? 

Material 

The material for the handle can be plastic or rubber. Each material has benefits over the 
other. For example, rubber may be easier to grip, just as on golf clubs. Plastic comes in 
many forms and colors.  

Color 

You should base the color you select for the handle on the current colors on the mini scooter 
and the color of the wheels.  
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The Design Solution 

Design a handle grip, then place the grips in the scooter assembly file.  

Create the handle grips 

1. Open Scooter Assembly.iam  

2. On the Assembly panel, click Create Component.  

3. Sketch the profile for your handle grip design.  

4. Create the handle grip feature.  

5. Place assembly constraints between the handle grip and the scooter handle.  

6. Place a second handle grip and apply assembly constraints between the handle grip and 
the scooter handle.  
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Project 2 - Design a desktop toy 

A company that designs and manufactures executive desktop toys has asked you to 
complete an existing design.  
 
The design criteria are available along with some pencil and paper sketches. You will 
complete the design evaluation and model the toy in Autodesk Inventor.  

 

Exercises 

• The design problem 

• The design solution 

Resources 

Design Basics Exercises 
Pre-Mechanical Exercises 
Related web pages 

Procedure 

1. Review the design criteria 
 
2. Review the sketches 
 
3. Design the components of the toy in Autodesk Inventor 
 
4. Assemble the components in Autodesk Inventor 
 
5. Use Drive Constraints to check your design. Save the animation as an AVI file. 
 
6. Document the model in Autodesk Inventor 
 
7. Create a portfolio of the design project 
 
8. Create a prototype model (optional) 
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The Design Problem 

Review the requirements for the design of the desktop toy. This includes, determining 
overall dimensions, shape, material and color.  

 

Dimensions 

The design criteria for the desktop toy states that the overall dimensions should not exceed 
150mm x 150mm x 75mm. This is to control the overall costs of the project and provide a 
suitable packaging and shipping solution.  

Shape 

The design criteria and sketches define what the shape of the toy will be. For example, the 
cylindrical rods move inside a circular barrel. 

Material 

The function of the toy means that the materials should be pleasing to the eye as well as 
functional. This project is a good example of form and function having similar importance.  
 
For example, the rods can be made from polished stainless steel.  

Color 

The color of the parts will depend on the steels selected. Research how steel can be colored 
using heat treatment.  
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The Design Solution 

Review the design sketches toy, then create the parts, assemble the model and document 
the assembly.  

Create a desktop toy 

1. Open project_02.pdf and project_02a.pdf  

2. Review the design criteria in the sketches.  

3. Model the parts.  

4. Assemble the parts and review the design.  

5. Use Drive Constraints to check the functionality of the assembly.  

6. Document the assembly.  
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Project 3 - Design a Puzzle Cube 

The content in this project is derived from the course Introduction to Engineering Design 
developed by Project Lead the Way, Inc. 

Exercises 

• The design problem 

Resources 

• Design Basics Exercises 

• Pre-Mechanical Exercises 

• Related web pages 

• Examples of utensil tray inserts 

Procedure 

1. Define the design problem 
 
2. Conceptualize the design 
 
3. Design the puzzle cube in Autodesk Inventor 
 
4. Assemble the puzzle cube in Autodesk Inventor 
 
5. Document the assembly in Autodesk Inventor 
 
6. Create a portfolio of the design project 
 
7. Create a prototype model (optional) 
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The Design Problem 

Students love to be challenged with puzzles. There are many kinds of puzzles on the market 
today. Are you ready to challenge someone’s mind? 

Design Statement 

Design a puzzle cube. 

Constraints 

• Puzzle must be a cube. 

• Puzzle will be fabricated from 27, ¾”hardwood cubes. 

• Must contain 5 parts. 

• Each part must be made from 3-6, ¾” cubes. 

• Some parts should interlock. 

Suggested Outputs 

3 view drawing with isometric view, fractional dimensioning, assembly view(s) in isometric, 
assemblage key, parts list and ballooning.  

Going Beyond 

Create an exploded isometric drawing based on a Presentation file.  

Skills Needed 

Basic knowledge of sketching, creating parts, assembling parts, and creating drawings in 
Autodesk Inventor.  
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Project 4 - Design Playground Equipment 

The content in this project is derived from the course Introduction to Engineering Design 
developed by Project Lead the Way, Inc. 

Exercises 

• The design problem 

Resources 

• Design Basics Exercises 

• Pre-Mechanical Exercises 

• Related web pages 

• Examples of utensil tray inserts 

Procedure 

1. Define the design problem 
 
2. Conceptualize the design 
 
3. Design the playground in Autodesk Inventor 
 
4. Assemble the playground in Autodesk Inventor 
 
5. Document the assembly in Autodesk Inventor 
 
6. Create a portfolio of the design project 
 
7. Create a prototype model (optional) 
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The Design Problem 

Play equipment must be designed and manufactured with several factors taken into 
consideration. The most important being: safety, ease of construction, and age appropriate 
sizing.  

Design Statement 

You and your team will design and build a piece of playground equipment to be used by a 4-
6 year old child. Using your knowledge of design process and model building you will 
construct a half scale model and provide all necessary documentation listed below. Extra 
credit may be earned by providing a fully annotated assembly drawing of your final design 
using Autodesk Inventor.  

Design Constraints 

• Size of 4-6 year old (height, hand grip, width, etc.). 

• Safety of equipment. 

• Originality. 

• Ease of Construction. 

Web Reference 

BigToys, Inc. (BigToys), is a manufacturer of environmentally friendly commercial 
playground equipment. For nearly 35 years, BigToys has earned a reputation as a 
manufacturer of high-quality commercial playground equipment for children. With an 
emphasis on caring for the environment as much as children, BigToys continues its role as a 
leader in the playground equipment industry by promoting environmental awareness and 
responsible stewardship of natural resources. 

Big Toys, Inc. 

Model Materials 

Teacher has: Glue guns, clear adhesive tape, coffee stirrers and flat toothpicks, 
miscellaneous cardboard, x-acto knives 

If you want to use something else, you may, but check with your teacher first. 

Skills Needed 

Basic knowledge of sketching, creating parts, assembling parts, and creating drawings in 
Autodesk Inventor.  
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Marking Criteria 

• Following specifications: 25 pts 

• Design steps followed and shown: 50 pts 

• Working drawings (include parts list): 50 pts 

• Design Originality: 25 pts 

• Model (scale 1=1 and neatness):50 pts 

• Total Possible: 200 points 
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Project 5 - Design a Cookie Cutter 

The content in this project is derived from the course Introduction to Engineering Design 
developed by Project Lead the Way, Inc. 

Exercises 

• The design problem 

Resources 

• Design Basics Exercises 

• Pre-Mechanical Exercises 

• Related web pages 

• Examples of utensil tray inserts 

Procedure 

1. Define the design problem 
 
2. Conceptualize the design 
 
3. Design the cookie cutter in Autodesk Inventor 
 
4. Document the part in Autodesk Inventor 
 
5. Create a portfolio of the design project 
 
6. Create a prototype model (optional) 
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The Design Problem 

You have been asked to bring homemade cookies to a special function. You would like to 
create large uniquely shaped cookies, but are unable to find a commercially available cookie 
cutter in the shape you desire. After talking to your technology teachers, they have 
suggested that you create your own using the Autodesk Inventor for the design and 1 mm 
thick copper sheets as material for construction.  

 

Design Statement 

Design and construct a custom shaped cookie cutter using equipment and materials 
available in the technology design lab. Use your knowledge of Inventor to create a solid 
model, orthographic drawing (with dimensions), and a sheet metal layout. The design can 
then be cut with the CNC laser, formed and assembled using lead free solder. 

Design Constraints 

• Four (40 minute) class periods, two for research, development, and design, one for 
cutting and forming, and one for assembly. 

• Material to be 1 mm thick copper. 

• 4-5” diameter cutter. 

• Must include an air hole on the top. 

• Recommended height of cutter: 15 mm, handle width: 15 mm.  

• Handle must be comfortable. 
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Skills Needed 

Basic knowledge of sketching, creating parts, assembling parts, and creating drawings in 
Autodesk Inventor. The Sheet Metal application can also be used.  

Follow Up Questions 

1. What other products could be made using a similar technique?  

2. If the handle design was changed could you make unique shaped pancakes, 
sandwiches, etc? 

3. What other materials could you use? What other forming processes are available? 

4. Can you think of alternative assembly methods? 
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Project 6 - Design an Improved Rack and Pinion 
Mechanism 

The content in this project is derived from the course Introduction to Engineering Design 
developed by Project Lead the Way, Inc. 

Exercises 

• The design problem 

Resources 

• Design Basics Exercises 

• Pre-Mechanical Exercises 

• Related web pages 

• Examples of rack and pinion mechanisms 

Procedure 

1. Define the design problem 
 
2. Conceptualize the design 
 
3. Design the mechanism in Autodesk Inventor 
 
4. Document the assembly in Autodesk Inventor 
 
5. Create a portfolio of the design project 
 
6. Create a prototype model (optional) 
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The Design Problem 

A customer was exceptionally pleased with the initial design of the Heavy Duty Rack Drive 
Assembly that you developed and animated with Autodesk Inventor drive constraints. This 
client was especially impressed by actuation of the assembly thru one cycle when your 
management team presented it to them. As a result, the customer has added some 
additional requirements for further evaluation. 

Design Statement 

Develop a new revision to the assembly by adding an additional driveshaft and related gear 
to the existing Assembly. 

Design Constraints 

• This driveshaft/gear combination is to be inserted precisely between the two existing 
driveshaft/gear elements at the same height so that the gearing meshes with the 
rack detail teeth. Since the actuation of the original design that was submitted was a 
major selling point we need to add the appropriate constraints and parameters so 
that the additional parts work in conjunction with the original gearing. The new 
design proposal should look similar to the following image: 

 

• Pegs must continue to work. 

Skills Needed 

Basic knowledge of sketching, creating parts, assembling parts, and creating drawings in 
Autodesk Inventor. The Sheet Metal application can also be used.  
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Suggested Outputs 

1. Orthographic and isometric views. Use a scale of 0.25 for the orthographic views and 
0.40 for the isometric view. 

2. The widths of the parts list columns are: 

o Description 40 mm. 

o Part Number 30 mm. 

o Material 45 mm. 
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Project 7 - Design Toy Blocks 

The content in this project is derived from the course Introduction to Engineering Design 
developed by Project Lead the Way, Inc. 

Exercises 

• The design problem 

Resources 

• Design Basics Exercises 

• Pre-Mechanical Exercises 

• Related web pages 

• Examples of toy blocks 

Procedure 

1. Define the design problem 
 
2. Conceptualize the design 
 
3. Design the toy blocks in Autodesk Inventor 
 
4. Document the assembly in Autodesk Inventor 
 
5. Create a portfolio of the design project 
 
6. Create a prototype model (optional) 
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The Design Problem 

Develop a children’s toy block system of stacking or interlocking or co-related parts  

Design Statement 

A recent market survey has indicated that many younger children prefer hand crafted, 
wooden toys to high production, plastic and metal toys. Very young children love to play 
with blocks – sorting, stacking or building with them. 

Design Constraints 

• Must create a minimum of 5 parts. 

• Must create a storage container for the blocks to fit into. 

• Parts must have the capability to interlock. 

• Must be able to be used by a 2-5 year old safely. 

Skills Needed 

Basic knowledge of sketching, creating parts, assembling parts, and creating drawings in 
Autodesk Inventor.  

Suggested Outputs 

1. Fully developed hand sketches of three design ideas. 

2. Documentation and drawings of at least three separate pieces. 

3. Documentation and drawings of at least one sample assembly of blocks. 
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Project 8 - Design a Bike Carrier 

The content in this project is derived from the course Introduction to Engineering Design 
developed by Project Lead the Way, Inc. 

Exercises 

• The design problem 

Resources 

• Design Basics Exercises 

• Pre-Mechanical Exercises 

• Related web pages 

• Examples of bike carriers 

Procedure 

1. Define the design problem 
 
2. Conceptualize the design 
 
3. Design the bike carrier in Autodesk Inventor 
 
4. Document the assembly in Autodesk Inventor 
 
5. Create a portfolio of the design project 
 
6. Create a prototype model (optional) 
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The Design Problem 

Transporting bicycles in or on a motor vehicle can be a painstaking and sometimes clumsy 
task. Simply throwing a bicycle in the bed of a pick-up truck is unsafe and can cause 
damage to both the truck and the bike. There needs to be a secure and efficient way of 
placing bicycles in the beds of pick-up trucks. 

Design Statement 

You are part of a design team who has the charge of creating a bicycle rack/carrier that will 
fit in the bed of pick-up trucks. Using the skills you have learned in Pre-Mechanical 
Engineering you will present your ideas in multiple view sketch form to the instructor. Upon 
approval you will translate your ideas to the solid modeling software showing all necessary 
views, dimensions, assemblies and parts lists. 

Design Constraints 

• Object must be lightweight and durable. 

• Easily attached/removed and transported. 

• Able to hold at least 2 bicycles safely. 

• Fully adjustable to fit several different size pick-up trucks. 

• Able to hold different size and style bicycles. 

Skills Needed 

Basic knowledge of sketching, creating parts, assembling parts, and creating drawings in 
Autodesk Inventor.  

Suggested Outputs 

1. Fully developed hand sketches of your design idea. 

2. Documentation and drawings of at least three separate pieces. 

3. Documentation and drawings of the assembly. 
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Project 9 - Design a Replica Construction Toy 

The content in this project is derived from the course Introduction to Engineering Design 
developed by Project Lead the Way, Inc. 

Exercises 

• The design problem 

Resources 

• Design Basics Exercises 

• Pre-Mechanical Exercises 

• Related web pages 

• Examples of replica construction toys 

Procedure 

1. Define the design problem 
 
2. Conceptualize the design 
 
3. Design the construction toy in Autodesk Inventor 
 
4. Document the assembly in Autodesk Inventor 
 
5. Create a portfolio of the design project 
 
6. Create a prototype model (optional) 
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The Design Problem 

A leading manufacturer of heavy-duty construction vehicles has had a history of awarding 
its best customers with a wooden, scale replica of one of its vehicles. Over the years, these 
replicas have become collector’s items. 

Design Statement 

Design a wooden, scale, replica of one of their construction vehicles and a stand or case for 
displaying this soon-to-be collectable. 

Design Constraints 

• Overall size not to exceed 300 mm x 300 mm x 300 mm (1' x 1' x 1'). 

• Short production run not to exceed $200 per unit. 

Skills Needed 

Advanced sketching, advanced placed features, and advanced assembly constraints.  

Suggested Outputs 

1. Fully developed hand sketches of your design idea. 

2. Documentation and drawings of at least three separate pieces. 

3. Several presentation views (IPN) of the assembly. 

4. Create a series of sequenced views of your final assembly that attempts to sell your 
product and create an AVI of your IPN file. 
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Project 10 - Design an underwater exploration 
vehicle 

The content in this project is derived from the course Introduction to Engineering Design 
developed by Project Lead the Way, Inc. 

Exercises 

• The design problem 

Resources 

• Design Basics Exercises 

• Pre-Mechanical Exercises 

• Related web pages 

• Examples of underwater exploration vehicle 

Procedure 

1. Define the design problem 
 
2. Conceptualize the design 
 
3. Design the construction toy in Autodesk Inventor 
 
4. Document the assembly in Autodesk Inventor 
 
5. Create a portfolio of the design project 
 
6. Create a prototype model (optional) 
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The Design Problem 

A jet-ski company has been hired to develop an underwater exploration vessel. Many people 
who are involved with water sports have been inquiring about this type of vehicle to explore 
reefs, sunken treasures and shipwrecks. 

Design Statement 

As the senior designer of this jet-ski company you have been assigned to design an 
underwater exploration vessel. 

Design Constraints 

• Two person capacity. 

• Maneuverability is paramount. 

• A target retail price is $10,000. 

• Must withstand depths up to 100 feet. 

• On board power plant is currently undetermined. 

Skills Needed 

Lofts, work planes, shell, and spline curves.  

Suggested Outputs 

1. Fully developed hand sketches of your design idea. 

2. Documentation and drawings of at least three separate pieces. 

3. Several presentation views (IPN) of the assembly. 

4. Create a series of sequenced views of your final assembly that attempts to sell your 
product and create an AVI of your IPN file. 
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